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Freies Notensatzprogramm
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Handbuch

Dieses Handbuch beschreibt Musescore 0.9.4 und alle neueren Versionen.
Wenn Sie mithelfen möchten das Handbuch zu verbessern oder
Übersetzungen zu erstellen, hinterlassen Sie bitte eine Nachricht im
englischsprachigen MuseScore Documentation bzw. Translation Forum.

http://musescore.org/de
http://www.musescore.org/en/forum/8
http://www.musescore.org/en/forum/9
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Kapitel 1

Erste Schritte

Dieses Kapitel hilft bei der Installation und dem ersten Start von MuseScore.
Es zeigt auch, wie eine neue Partitur erstellt wird.

Installation

Windows
Sie finden die Windows-Installationsdatei auf der Download-Seite von
musescore.org. Klicken Sie dort auf den Link, um den Download zu starten.
Wenn Ihr Browser Sie um Bestätigung bittet, wählen Sie bitte "Speichern".

Wenn der Download abgeschlossen ist, führen Sie die heruntergeladene
Datei aus, um die Installation zu starten. Wenn Windows einen Warnhinweis
einblendet, bestätigen Sie bitte die Ausführung des Programms.

Es wird empfohlen, alle anderen Anwendungen zu schließen, bevor Sie mit
der Installation fortfahren. Klicken Sie danach "Weiter".

http://musescore.org/de/download
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Das Installationsprogramm zeigt Ihnen die Lizenzbedingungen an, unter
denen die Software verwendet werden darf. Bestätigen Sie diese, um
fortzufahren.

Im nächsten Schritt werden Sie nach dem Ort gefragt, an dem Sie
MuseScore installieren möchten. Wenn Sie eine ältere Version von
MuseScore behalten möchten, empfehlen wir, den Namen des
Zielverzeichnisses zu ändern. Wenn Sie mit der Wahl einverstanden sind,
fahren Sie fort.

Als Nächstes können Sie den Namen des Ordners wählen, der im Startmenü
unter Programme angezeigt wird. Hier kann die Voreinstellung beibehalten
werden. Klicken Sie "Installieren" um fortzufahren.

Wir bitten Sie um ein paar Minuten Geduld, bis MuseScore fertig installiert
ist. Nach Abschluss der Installation drücken Sie bitte "Beenden", um das
Installationsprogramm zu verlassen. Wenn Sie möchten, können Sie jetzt die
heruntergeladene Installationsdatei wieder löschen.

MuseScore starten
Sie finden MuseScore unter Start → Programme → MuseScore → MuseScore.

MuseScore wird mit einer Demo-Partitur gestartet. Sie können gleich
beliebig mit der mitgelieferten Partitur experimentieren, um das Programm
kennenzulernen. Ihr nächster Schritt wird wahrscheinlich die Erstellung
einer neuen Paritur sein.
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Für fortgeschrittene Benutzer: unbeaufsichtigte Installation
Sie können MuseScore mit dem folgenden Befehl unbeaufsichtigt (d.h.
nicht-interaktiv) installieren:
MuseScore-1.1.exe /S /D=C:\Programme\MuseScore

Zur Deinstallation können Sie die folgenden Befehle ausführen:
cd C:\Program Files\MuseScore

Uninstall.exe /S

Mac OS X

Installation
Sie finden eine dmg-Datei für Mac OS X auf der Download-Seite von
musescore.org. Klicken Sie dort auf den Link, um den Download zu starten.
Wenn der Download abgeschlossen ist, wird die dmg-Datei automatisch als
"MuseScore-0.9.6" auf Ihrem Desktop eingebunden und das
Installationsprogramm öffnet sich.

http://musescore.org/de/download
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Ziehen Sie das MuseScore-Symbol in den Anwendungsordner. Wenn nicht
als Administrator angemeldet sind, wird Mac OS X Sie nach Ihrem Passwort
fragen. Geben Sie dieses ein und klicken Sie auf "OK", um Mac OS X zu
erlauben, MuseScore in Ihren Anwendungsordner zu kopieren. Sie können
MuseScore danach wie gewohnt aus dem Anwendungsordner oder per
SpotLight starten.

Deinstallation
Löschen Sie MuseScore aus dem Anwendungsordner.

Linux
Installationsanweisungen für Linux finden Sie auf der Download-Seite auf
musescore.org. Es werden Pakete für Debian, Ubuntu, Fedora und
PCLinuxOS bereitgestellt. Andere Distributionen verwenden entweder einen
der oben genannten Pakettypen oder benötigen eine installation aus einem
Quelltextpaket. Wenn Sie Fedora verwenden, beachten Sie bitte den
folgenden Abschnitt.

Fedora
Sie benötigen den GPG-Key:

http://musescore.org/de/download
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su

rpm --import http://prereleases.musescore.org/linux/Fedora/RPM-GPG-KEY-Seve

2. Öffnen Sie die Download-Seite von musescore.org in Ihrem Browser.
Klicken Sie auf den Link für den Fedora-Stable-Download und wählen Sie
das zu ihrer Rechnerarchitektur passende rpm-Paket.

3. Je nach vorhandener Architektur installieren Sie Musescore wie folgt:

i386

su

yum localinstall musescore-0.9.4-1.fc10.i386.rpm

x86_64

su

yum localinstall musescore-0.9.4-1.fc10.x86_64.rpm

Bei Schwierigkeiten mit der Audio-Wiedergabe auf Fedora-Systemen, lesen
Sie bitte den folgenden Foren-Beitrag (englisch): Fedora 11 and sound.

Neue Partitur erstellen

Neue Partitur erstellen
Wählen Sie bitte aus dem Hauptmenü Datei → Neu.... Es erscheint der
Assistent für eine neue Partitur.

Titel, Komponist und weitere Informationen

Geben Sie entsprechende Informationen für Titel, Komponisten und je nach 
Bedarf weitere Felder ein.

http://musescore.org/de/download
http://www.musescore.org/en/node/3848#comment-9634
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Weiter unten können Sie unter zwei Optionen wählen, welche Art Partitur
Sie erstellen möchten.

• Neue Partitur aus Vorlage erstellen

• Neue Partitur ohne Vorlage erstellen

Mit der ersten Option können Sie im weiteren Verlauf eine fertige
Partiturvorlage wählen, mit der Sie Ihre Partitur erstellen möchten, die
zweite Option ermöglicht dagegen die freie Auswahl der gewünschten
Instrumente und anderer Einstellungen. Vorlagen werden weiter unten im
Detail besprochen, wir befassen uns zunächst mit der Option „Neue Partitur
erzeugen”.

Um zum nächsten Schritt zu gelangen, klicken Sie bitte auf „Weiter”.

Stimmen und Instrumente

Das Instrumentenfenster ist in zwei Hälften unterteilt. Die linke Hälfte zeigt
die auswählbaren Stimmen und Instrumente. Die rechte Hälfte ist anfangs
leer und enthält nach dem Auswählen die Intrumente der neuen Partitur.

Die Instrumentenliste links ist kategorisiert nach Instrumenten-Familien. Ein
Doppelklick auf eine Kategorie zeigt die komplette Liste der zugehörigen
Instrumente. Wählen Sie ein Instrument aus und klicken Sie „Hinzufügen”,
danach erscheint dieses Instrument in der rechten Hälfte. Fügen Sie so viele
Instrumente hinzu, wie Sie möchten.

Die Reihenfolge der Instrumente in der rechten Hälfte entspricht der in der
Partitur. Um diese zu ändern, wählen Sie ein Instrument aus und klicken Sie
auf
„Nach oben” oder „Nach unten”, um seine Position zu verändern. Wenn Sie
fertig sind, klicken Sie bitte auf „Weiter”.

Tonart (Vorzeichen)
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Wenn Sie die neueste Version von MuseScore verwenden, können Sie als
nächstes die Vorzeichen für Ihre Partitur wählen. In frühere Versionen
existiert dieser Schritt nicht, die Vorzeichnung kann nach Erstellung der
Partitur noch geändert werden.

Wähle Sie die gewünschten Tonart aus und klicken Sie auf „Weiter”.

Taktart, Auftakt und Taktanzahl

Falls >Ihre Partitur mit einem Auftakt beginnen soll, wählen die Option
„Auftakt” und stellen Sie dessen Dauer entsprechend ein.

Geben Sie auch die ungefähre Anzahl an benötigten Takten ein, Sie können
später beliebig Takte zu ihrer Partitur hinzufügen oder entfernen.

Klicken Sie auf „Abschließen” um die neue Partitur zu erstellen.

Anpassungen der Partitur nach dem Erzeugen
Sie können sämtliche Einstellungen, die Sie im Assistenten vorgenommen
haben, auch während der Bearbeitung der Partitur verändern.
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• Um Takte zu löschen oder hinzuzufügen oder einen Auftakt zu erzeugen
siehe Takte bearbeiten.

• Um Texte zu ändern, siehe Text bearbeiten. Um einen fehlenden Titel
(oder anderen Text) hinzuzufügen, benutzen Sie aus dem Menü Einfügen
→ Text → Titel (oder eine andere Textart).

• Um Instrumente hinzuzufügen, zu löschen oder deren Reihenfolge zu
ändern, benutzen Sie aus dem Menü Einfügen → Stimmen/Instrumente....

Siehe auch: Tonart, Taktart, Schlüssel.

Vorlagen
Die erste Seite des Assistenten für eine neue Partitur hat eine Option, um
eine Partitur aus einer Vorlage zu erzeugen (siehe Titel, Komponist und
weitere Informationen oben für Details). Um eine Partitur mit dieser
Methode zu erzeugen, wählen Sie die Vorlagen-Option und klicken Sie auf
„Weiter”.

Die nächste Seite zeigt eine Auswahl von Vorlagen. Wählen Sie eine aus und
klicken Sie auf „Weiter”. Danach fahren Sie wie gewohnt fort.

Die Vorlagen-Dateien sind normale MuseScore-Dateien, die im
Vorlagenordner gespeichert sind. Sie können eigene Vorlagen erzeugen,
indem Sie MuseScore-Dateien in diesem Ordner speichern. Unter Windows
liegt der Vorlagenordner üblicherweise unter
C:\Programme\MuseScore\templates. Unter Linux finden Sie den
Vorlagenordner für gewöhnlich entweder oder /usr/share/mscore-xxx
/templates, oder unter /usr/local/share/mscore-xxx/templates.

Weblinks
• Video tutorial: Score Setup (englisch mit deutschen Untertiteln)

http://musescore.org/nb/h�ndbok/taktart
http://www.youtube.com/watch?v=0mh6m2mbvhs
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Kapitel 2

Grundlagen

Das vorherige "Erste Schritte" Kapitel führte Sie durch die Installation und
den Prozess einen neue Partitur zu erstellen. Dieses "Grundlagen" Kapitel
hier gibt einen Überblick über MuseScore und beschreibt die generellen
Methoden eine Partitur zu bearbeiten.

Noteneingabe
Noten werden im Noteneingabemodus eingegeben. Bevor Sie in den
Eingabemodus wechseln, wählen Sie bitte eine Position in der Partitur aus,
ab der die Noteneingabe erfolgen soll, das kann eine beliebige Note oder
Pause sein. Beachten Sie bitte, dass vorhandene Noten und Pausen durch
Ihre Eingabe ersetzt werden. Wenn Sie eine Passage einfügen möchten,
erstellen Sie erst die benötigte Anzahl leerer Takte an der gewünschten
Position in Ihrer Partitur, bevor Sie Noten einfügen.

• N Noteneingabemodus starten.

• Escape Noteneingabemodus beenden.

Nachdem Sie in den Noteneingabemodus gewechselt haben, sollten Sie
entweder aus der Symbolleiste oder mit der Tastatur eine Dauer auswählen,
mit der Sie Noten oder Pausen eingeben möchten.

Ab der Version 0.9.4 lautet die Tastaturbelegung für die Auswahl von
Tondauern:

• 1: 64tel-Note

• 2: 32tel-Note

• 3: 16tel-Note

• 4: Achtelnote

• 5: Viertelnote
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• 6: Halbe Note

• 7: Ganze Note

• 8: Doppelte Ganze Note

• 9: Longa

• .: Punktierung zur markierten Note hinzufügen

Bis zur Version 0.9.3 war die Tastatur anders belegt:

• Alt+1: Viertelnote

• Alt+2: Achtelnote

• Alt+3: 16tel-Note

• Alt+4: 32tel-Note

• Alt+5: 64tel-Note

• Alt+6: Ganze Note

• Alt+7: Halbe Note

• .: Punktierung zur markierten Note hinzufügen

Die Eingabe von Noten erfolgt über ihren Namen mit den Tasten C D E F G A B
(für H) und C

Mit der 0 (Null) erzeugen Sie eine Pause: C D 0 E. Sie werden merken, dass
die Dauer, die sie ausgewählt haben, sowohl für Noten, als auch für Pausen
gilt

Bitte beachten Sie, dass in älteren Versionen von MuseScore Pausen mit der
Leertaste eingegeben wurden. In neueren Versionen starten Sie mit der
Leertaste die Wiedergabe der Partitur.

Während der Eingabe rückt MuseScore automatisch in Ihrer Partitur vor.
Wenn Sie das nicht möchten, sondern eine weitere Note zu Ihrer letzten
Eingabe hinzufügen wollen, so dass ein Akkord entsteht, drücken und halten
Sie die Umschalt⇑-Taste und geben dann den Notennamen ein, den Sie
hinzufügen möchten, zum Beispiel: C D Umschalt⇑+F Umschalt⇑+A E F

Wenn Sie eine punktierte Note eingeben möchten, drücken Sie .. Beispiel: 5 . 
C 4 D E F G A (Anmerkung: Versionen bis 0.9.3 verwenden andere 
Tastenbelegungen für die Noteneingabe, siehe oben)
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Sie können den zuletzt eingegebenen Ton um jeweils eine Oktave
verschieben:

• Strg+↑ (Mac: ⌘+↑): Note um eine Oktave nach oben versetzen.

• Strg+↓ (Mac: ⌘+↓): Note um eine Oktave nach unten versetzen.

Weitere Tastaturbefehle:

• x: Richtung des Notenhalses umdrehen.

• Umschalt⇑+x: Notenkopf an anderen Seite des Halses befestigen.

MIDI-Keyboard
Ab Version 0.9.6 können Sie Tonhöhen auch mit einem MIDI-Keyboard
eingeben. Bis zur Version 0.9.3 wird die MIDI-Eingabe nur auf
Linux-Betriebssystemen unterstützt.

1. Schließen Sie Ihr MIDI-Keyboard an Ihren Computer an und
vergewissern Sie sich, dass es angeschalten ist

2. Starten Sie MuseScore

3. Erstellen Sie eine neue Partitur

4. Klicken Sie auf die Pause im ersten Takt um dort mit der Noteneingabe
zu beginnen

5. drücken Sie N um in den Noteneingabemodus zu wechseln

6. Wählen Sie eine Tondauer aus, z.B. 5 für Viertelnoten (siehe oben)

7. Drücken Sie einen Taste auf ihrem MIDI-Keyboard, der entsprechende
Ton wird in Ihre Partitur eingefügt

Beachten Sie bitte: mit dem MIDI-Keyboard können Sie jeweils einen einzeln
Ton oder einen Akkord eingeben. Die oben beschrieben Art der
Noteneingabe mit einem MIDI-Keyboard - sie wird auch manchmal
"Step-Time" genannt - ist schnell und präzise. Es gibt Notationsprogramme
die einen "Real-Time"- oder Echtzeitmodus anbieten, in dem Sie eine
Passage in Echtzeit einspielen können, die von der Notationssoftware
aufgeschrieben wird. Diese Art der Eingabe ist oft sehr ungenau und die
Resultate unbefriedigend, selbst wenn ein erfahrener Musiker mit sehr
teurer Software einspielt. Besonders auf PC-Rechnerarchitekturen treten
außerdem hardwarebeding Probleme mit zu großen Latenzzeiten auf -
Latenz ist die Laufzeit eines Signals vom Tastendruck auf dem
MIDI-Keyboard bis zur Software - die eine genaue Umsetzung nahezu
unmöglich machen. MuseScore bietet daher nur die beiden oben genannten,
zuverlässigen Eingabemodi an.
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Wenn Sie mehrere MIDI-Geräte an ihren Computer angeschlossen haben,
kann es sein, dass Sie MuseScore mitteilen müssen, welches davon ihr
MIDI-Eingabegerät ist. Ab Version 0.9.6 können Sie rufen Sie den
Menüpunkt Bearbeiten → Einstellungen... (Mac: MuseScore → Einstellungen...) auf.
Im Dialogfenster, das sich öffnet, Klicken Sie den Reiter I/O an und wählen
Sie unter „PortMidi Eingang auswählen” Ihr Eingabegerät aus.

Einfärbung von Noten außerhalb des darstellbaren Tonumfangs
Ab der Version 0.9.5 färbt MuseScore Noten, die sich außerhalb des für
einen Spieler darstellbaren Tonumfangs eines Instruments befinden, rot oder
gelb ein. Hierbei wird gelb verwendet, wenn sich eine Note außerhalb des
für einen Laien bequem spiel- oder singbaren Tonumfang befindet, Töne die
entweder garnicht spielbar sind, oder außerhalb des für Profis realistisch
umsetzbaren Tonumfangs befinden, werden rot dargestellt. Die Einfärbung
ist rein informeller Natur und in Ausdrucken nicht sichtbar. Wenn Sie die
Einfärbung von Noten deaktivieren möchten (dies ist ab Version 0.9.6
möglich), wählen sie im Menü Bearbeiten → Einstellungen... (Mac: MuseScore →
Einstellungen...), wählen Sie dort den Reiter Noteneingabe und entfernen Sie
die Markierung für „Noten außerhalb des darstellbaren Tonumfangs
einfärben”.

Weblinks
• Video tutorial: Note entry basics (englisch mit deutschen Untertiteln)

• Video tutorial: Note Entry with a MIDI Keyboard and Playback (englisch
mit deutschen Untertiteln)

Kopieren und Einfügen
Kopieren und Einfügen nützlich für sich wiederholende Elemente oder um
einen Abschnitt um ein oder mehrere Zählzeiten zu verschieben.

Kopieren
1. Klicken Sie auf die erste Note ihrer Auswahl

2. Umschalt⇑+Klicken Sie auf die letzte Note Ihrer Auswahl. Ein blaues
Rechteck sollte den ausgewählten Bereich hervorheben

3. Wählen Sie im Menü wählen Sie Bearbeiten → Kopieren

Einfügen
1. Klicken Sie auf die erste Note oder den ersten Takt, um den Beginn des

Einfügens festzulegen

2. Wählen Sie im Menü Bearbeiten → Einfügen

http://www.youtube.com/watch?v=ugzgezapbge
http://www.youtube.com/watch?v=rxy3ieufxjm
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Weblinks
• Video tutorial: Lyrics, Copying & Dynamics (englisch)

Bearbeitungsmodus
Viele Elemente der Partitur können im Bearbeitungsmodus verändert
werden.

• Doppelklick startet den Bearbeitungsmodus

• Escape beendet den Bearbeitungsmodus

Einige Elemente zeigen im Bearbeitungsmodus Anfasser, die mit der Maus
oder mit Tastaturkommandos verschoben werden können.

Haltebögen im Bearbeitungsmodus:

Verfügbare Tastaturkommandos:

• ←: verschiebt Anfasser ein Spatium nach links

• →: verschiebt Anfasser ein Spatium nach rechts

• ↑: verschiebt Anfasser ein Spatium nach oben

• ↓: verschiebt Anfasser ein Spatium nach unten

• Strg+← (Mac: ⌘+←): verschiebt Anfasser 0,1 * Spatium nach links

• Strg+→ (Mac: ⌘+→): verschiebt Anfasser 0,1 * Spatium nach rechts

• Strg+↑ (Mac: ⌘+↑): verschiebt Anfasser 0,1 * Spatium nach oben

• Strg+↓ (Mac: ⌘+↓): verschiebt Anfasser 0,1 * Spatium nach unten

• Umschalt⇑+←: Bewegt den Ankerpunkt eine Position nach links

• Umschalt⇑+→: Bewegt den Ankerpunkt eine Position nach rechts

• Tab gehe zum nächsten Anfasser

Siehe auch: Text bearbeiten, Haltebögen, Klammern, Linien.

Takte bearbeiten

Takte anhängen
Um einen Takt an das Ende der Partitur anzuhängen, drücken Sie bitte 
Strg+B (Mac: ⌘+B), oder rufen Sie im Menü Einfügen → Takte → Takt anhängen

http://www.youtube.com/watch?v=e55-ynhsk-s
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auf. Um mehrere Takte anzuhängen, drücken Sie bitte Strg+Umschalt⇑+B (Mac:
⌘+Umschalt⇑+B), oder wählen Sie im Menü Einfügen → Takte → Takte anhängen....

Takte einfügen
Wählen Sie bitte zuerst einen Takt aus und drücken Sie dann Einfg, oder
wählen Sie im Menü Einfügen → Takte → Takt einfügen, um vor dem
ausgewählten Takt einen neuen Takt einzufügen. Um mehrere Takte
einzufügen, drücken Sie Strg+Einfg, oder rufen Sie im Menü Einfügen → Takte →
Takte einfügen... auf.

Takte löschen
Wählen Sie zuerst einen oder mehrere Takte aus und drücken Sie dann
Strg+Entf (Mac: ⌘+Fn+Rücktaste).
Bis zur Version 0.9.5: Drücken Sie Strg (Mac: ⌘) um mit einem Mausklick in
einen leeren Bereich eines Taktes einen Takt auszuwählen. Der Takt ist dann
mit einer gestrichelten Linie umrandet um anzuzeigen, dass eine komplette
Zeiteinheit ausgewählt wurde. Drücken Sie Strg+Klick (Mac: ⌘+Klick), um die
Auswahl zu erweitern. Drücken Sie Entf (Mac: Fn+Rücktaste) um die
ausgewählten Takte zu entfernen.

Eigenschaften
Um die Eigenschaften eines Taktes zu bearbeiten, rufen Sie mit einem
Rechtsklick in einen freien Bereich eines Taktes das Kontextmenü auf und
wählen Sie Eigenschaften Takt....

Notenzeilen
Mit der Option „sichtbar” können Sie einzelne Notenzeilen des ausgewählten
Taktes verstecken oder sichtbar machen. Die Option „halslos” macht alle
Notenhälse für den ausgewählten Bereich unsichtbar. Für Noten, die
normalerweise einen Hals haben, wird nur der Notenkopf angezeigt.

Dauer
Die nominelle Dauer ist die Dauer, die durch die Taktangabe in Ihrer Partitur 
vorgegeben ist. Sie können die effektive Dauer eines Taktes beliebig ändern. 
Normalerweise sind nominelle und effektive Dauer eines Taktes identisch.
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Auftakte jedoch zum Beispiel haben eine kürzere effektive als nominelle
Dauer.

In der untenstehenden Abbildung hat der Auttakt eine nominale Dauer von
4/4 aber eine effektive Dauer von 1/4. Die beiden folgenden Takte haben
sowohl eine nominale als auch eine effektive Dauer von 4/4. Der letzte Takt
enthält nur eine punktierte Halbe Note und hat eine effektive Dauer von 3/4.

Irregulär
Ein „irregulärer” Takt wird bei der Nummerierung der Takte nicht
berücksichtigt. Üblicherweise haben Auftakte die Eigenschaft „irregulär”.
Wenn Sie Version 0.9.4 oder eine frühere verwenden und einen Takt als
irregulär kennzeichnen, müssen Sie unter Umständen Ihre Partitur
speichern und neu laden, damit die Taktzahlen aktualisiert werden.

Addiere zu Taktnummer
Sie können auch die Option "Addiere zu Taktnummer" verwenden um die
Nummerierung der Takte anzupassen. Sie können dazu eine positiv oder
negativ Zahl angeben. Bitte beachten Sie, dass eine sich Änderung auf die
Nummerierung aller folgenden Takte auswirkt. Der Wert „-1” ergibt das
selbe Resultat wie bei einem „irregulären” Takt.

Layout-Dehnung
Hiermit können Sie den horizontalen Freiraum zwischen den Noten
vergrößern oder verkleinern.

Wiederholungszähler
Ist der Takt das Ende einer Wiederholung, kann hier die Anzahl der
Durchgänge angegeben werden, die durchlaufen werden sollen.

Mehrtaktpausen aufbrechen
Diese Eigenschaft trennt eine Mehrtaktpause am Anfang des gewählten
Taktes auf. Sie sollten diese Option auswählen bevor Sie unter Format →
Format-Stilvorgaben bearbeiten... die Option „Mehrtaktpausen erstellen”
aktivieren.

Ab Version 0.9.6 werden Mehrtaktpausen automatisch an wichtigen Punkten
unterbrochen, wie zum Beispiel an Probenmarkierungen, Taktwechseln, oder
Doppelstrichen.

Taktzahlen
MuseScore zeigt automatisch Taktzahlen am Anfang eines Systems an, aber
es sind mehrere Einstellungen möglich. Wählen Sie im Menü Format →
Format-Stilvorgaben bearbeiten.... Wählen Sie dort im linken Auswahlfeld
„Zahlen”. In der unteren Hälfte auf der rechten Seite befindet sich der
Abschnitt „Taktzahlen”.
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Aktivieren Sie die Option „Taktzahlen” um die automatische Erstellung von
Taktzahlen zu aktivieren.
Wählen Sie „erste anzeigen”, wenn der erste Takt eine Taktzahl bekommen
soll.
Wählen Sie „alle Notenzeilen” wenn in jeder Notenzeile eine eigene Taktzahl
stehen soll, sonst bekommt nur die oberste Zeile eines Systems eine
Taktzahl.
Sie können außerdem auswählen ob „jedes System” eine Taktzahl bekommen
soll, dann bekommt jeweils der erste Takt eines Systems eine Taktzahl, oder
„Intervall” wählen und eine Zahl wählen. Wenn Sie zum Beispiel als Intervall
1 angeben, bekommt jeder Takt eine Taktzahl, wenn Sie 5 als Intervall
wählen, wird jeder fünfte Takt nummeriert.

Palette
Sie können die Werkzeugpalette mit dem Menüpunkt Ansicht → Palette
anzeigen oder verbergen. Sie können diese Funktion auch mit F9 aufrufen.

Die Werkzeugpalette enthält Symbole, die mittels Drag&Drop auf Elemente
der Partitur gezogen werden können.

Ein Doppelklick auf ein Palettenelement hat den selben Effekt, als ob dieses
Element auf alle ausgewählten Elemente der Partitur gezogen würde. Damit
können z.B. auf einfache Weise mehrere Noten mit einem Tenuto-Zeichen
versehen werden.

Beispiel:

1. Noten auswählen

2. Doppelklick auf das Tenuto-Symbol in der Palette "Artikulation &
Verzierungen"

Rückgängig und Wiederherstellen
MuseScore kann beliebig viele Aktionen rückgängig machen. Die
Standardtastaturabkürzungen sind:

• Rückgängig machen Strg+Z (Mac: ⌘+Z)

• Wiederherstellen Strg+Umschalt⇑+Z or Strg+Y (Mac: ⌘+Umschalt⇑+Z)

Oder verwenden Sie die Symbolleiste:
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Exportieren
Eine Partitur kann über das Pulldownmenü Datei → Speichern als... in
verschiedenen Formaten exportiert werden:

Komprimiertes MuseScore format (*.mscz)

MSCZ ist das Standard-MuseScore-Dateiformat und wird für die meisten
Anwendungen empfohlen. Eine Partitur wird mit diesem Format
möglichst platzsparend gespeichert, enthält aber alle Informationen der
Partitur. Dieses Format ist die ZIP-komprimierte Version des
.mscx-Dateiformats.

MuseScore format (*.mscx)

MSCX ist die unkomprimierte Version des MuseScore-Dateiformats und
steht ab Version 0.9.5 oder später zur Verfügung. Eine Partitur in diesem
Format enthält ebenfalls alle Informationen, kann aber in einem
Text-Editor bearbeitet werden. Ältere Versionen von MuseScore
verwenden das MSC-Dateiformat. Die MSC-Dateiendung kann jedoch zu
Konflikten unter Microsoft Windows führen und wird von manchen
E-Mail-Providern gesperrt. Das neue MSCX-Format ersetzt das ältere
MSC-Format um diese Probleme zu umgehen.

MusicXML (*.xml)

MusicXML ist ein allgemeines Standardformat zum Austausch von Musik
und wird von den gängigen Notensatzprogrammen unterstützt, wie unter
anderem Sibelius, Finale und viele weitere mehr. Es ist das Empfohlene
Format um Partituren zwischen verschiedenen Notensatzprogrammen
auszutauschen.

Komprimiertes MusicXML (*.mxl)

Komprimiertes MusicXML erzeugt kleinere Dateien als das normale
MusicXML-Format. Komprimiertes MusicXML ist ein neuerer Standard
und nicht so weit verbreitet, wie die unkomnprimierte Version.

MIDI (*.mid)

„Musical Instrument Digital Interface” (MIDI) ist ein Format das weit
verbreitet ist unter Squenzern und Notationsprogrammen. MIDI-Dateien
wurden jedoch vorrangig für die Audio-Wiedergabe und nicht für
Partitur-Layout entwickelt, daher enthalten Sie keine Informationen über
Dinge wie Formatierung, Vorzeichenwahl, Stimmverteilung,
Verzierungen, Artikulationen, Wiederholungen oder Tonartvorzeichen.
Wenn Sie Partituren zwischen verschiedenen Notationsprogrammen
austauschen wollen, verwenden Sie lieber MusicXML. Wenn der
Schwerpunkt bei der Audio-Wiedergabe liegt, ist das MIDI-Format
geeignet.

http://www.recordare.com/xml.html


19

PDF (*.pdf)

Das „Portable Document Format” (PDF) ist ideal um Partituren
weiterzugeben, die von anderen nicht bearbeitet werden müssen. Die
meisten Computer haben eine Software zur Anzeige von PDF-Dateien, es
muss also keine Zusätzliche Software installiert werden, um Ihre
Partituren anzeigen zu können.

PostScript (*.ps)

PostScript (PS) ist eine Seitenbeschreibungssprache, die im
Druckbereich verbreitet ist.

PNG (*.png)

Das „Portable Network Graphics” (PNG) ist ein Bildformat, das auf allen
verbreiteten Betriebssystemen unterstützt wird und oft in
Bildbearbeitungssoftware sowie im Internet verwendet wird. Ab der
Version 0.9.3 exportiert MuseScore eine PNG-Datei pro Partiturseite.
MuseScore exportiert als Bilder, was als Druckergebnis sichtbar wäre.
Wenn Sie Bilder erzeugen möchten, die Elemente anzeigen, die nur auf
dem Bildschirm sichtbar sind, wie zum Beispiel Rahmen, unsichtbare
Noten und die Einfärbung für Noten außerhalb des Tonumfangs, wählen
Sie im Menü Bearbeiten → Einstellungen... (Mac: MuseScore → Einstellungen...),
rufen Sie den Export-Reiter auf und wählen Sie die "Bildschirmfoto
Funktion" Option aus.

SVG (*.svg)

Scalable Vector Graphics (SVG) kann in den meisten Web-Browsern
geöffnet werden (außer dem Internet Explorer) und in Software zur
Bearbeitung von Vektorgrafiken. Die meisten SVG-Programme
unterstützen jedoch keine eingebetteten Fonts, daher müssen die
passenden MuseScore-Fonts installiert sein, um diese Dateien korrekt
anzuzeigen.

LilyPond (*.ly)

Das LilyPond-Format kann mit dem Notationsprogramm Lilypond
geöffnet werden. Der LilyPond-Export funktioniert noch nicht vollständig
und ist in aktuellen Versionen von MuseScore noch experimentell.

WAV Audio (*.wav)

WAV (Waveform Audio Format) ist ein unkomprimiertes Audio-Format 
das von Microsoft und IBM entwickelt wurde, aber von einer großen 
Vielfalt von Software für Windows, Mac OS und Linux unterstützt wird. 
Es ist ideal geeignet um Audio-CDs herzustellen, da beim Speichern in 
diesem Format kein Qualitätsverlust auftritt. Die Größe der Dateien 
macht es jedoch schwierig dieses Format zum Austausch über E-Mail

http://lilypond.org
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oder im Internet zu verwenden. Diese Export-Option ist erst ab
MuseScore-Version 0.9.5 oder neuer verfügbar.

FLAC Audio (*.flac)

Free Lossless Audio Codec (FLAC) ist ein komprimiertes Audio-Format.
FLAC-Dateien haben ungefähr die Hälfte der Größe von
unkomprimierten Audio-Dateien, die Komprimierung ist jedoch
verlustfrei, die Originalqualität bleibt erhalten. Windows and Mac OS
haben keine eingebaute Unterstützung für FLAC, aber Software wie zum
Beispiel der VLC media player kann FLAC-Dateien auf jedem
Betriebssystem abspielen. Dieses Format steht ab Version 0.9.5 oder
später zur Verfügung.

Ogg Vorbis (*.ogg)

Ogg Vorbis wurde als patentfreier Ersatz für das beliebte MP3-Format
entwickelt. Wie auch MP3-Dateien sind Ogg-Vorbis-Dateien
vergleichsweise klein (oftmals ein Zehntel der Größe unkomprimierter
Dateien), aber ein gewisser Qualitätsverlust tritt dabei auf. Windows und
Mac OS haben keine eingebaute Unterstützung für Ogg-Vorbis. Der VLC
Media Player und Firefox 3.5 oder neuer können Ogg-Vorbis Dateien auf
allen Betriebssystemen wiedergeben. Dieses Format steht ab Version
0.9.5 oder später zur Verfügung.

Partitur Online mit anderen teilen
Gehen Sie zu http://musescore.com/sheetmusic, um sich andere Partituren
von MuseScore anzusehen.

Sie können Ihre Partituren online bei MuseScore.com speichern und mit
anderen teilen.
Sie haben die Wahl Ihre Partituren privat für Ihren persönlich Zugriff, von
jedem beliebigen Computer aus, zu speichern oder ihn öffentlich oder auch
nur für Freunde, Band Mitglieder, etc. zum Anschauen und Herunterladen
zur Verfügung zu stellen. Mit MuseScore.com können Sie die Partituren
anschauen und im Web Browser wiedergeben, es ist sogar möglich sie mit
YouTube Videos zu synchronisieren. Für die Benutzung außerhalb eines Web
Browsers können Sie die Partituren in verschieden Formaten herunterladen
(incl. PDF, MIDI, MusicXML und dem original MuseScore Format).

Hinweis: MuseScore.com ist bisher ausschließlich in englischer Sprache
verfügbar. Die relevanten Menus und Dialoge in MuseScore sind seit Version
1.2 auch auch in Deutsch verfügbar. Die Bilder unten zeigen noch die
englische Version.

Konto anlegen

http://www.videolan.org/vlc/
http://www.videolan.org/vlc/
http://www.videolan.org/vlc/
http://musescore.com/sheetmusic
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1. Besuchen Sie MuseScore.com und klicken auf Create account

2. Wählen Sie sich einen Benutzernamen, geben eine gültige E-Mail
Adresse ein und drücken dann "Create new account"

3. Warten Sie ein paar Minuten auf eine E-Mail vom MuseScore.com
Support. Wenn keine E-Mail ankommt, überprüfen Sie Ihren
Spam-Ordner

4. Klicken SIe auf dem Link in der E-Mail und besuchen Ihr User Profile,
um Ihr Password zu ändern

Partituren direkt aus MuseScore heraus mit anderen teilen
Sie können Ihre Partitur direkt Online speichern über Datei → Online
speichern.... Wenn Sie dies zum ersten Mal tuen, müssen Sie sich anmelden.

Erste Anmeldung

1. Gehen SIe zu Datei → Online speichern...

2. MuseScore bittet Sie auf OK zu klicken um Ihren Browser zu starten
und MuseScore die Erlaubnis zu geben sich mit MuseScore.org zu
verbinden.

3. Klicken Sie auf OK und Ihr Browser öffnet MuseScore.com. Wenn Sie
dort nicht angemeldet sind, geben Sie jetzt Benutzername und Passwort
ein und

4. klicken auf "Allow Access"

5. Gehen Sie zurück zu MuseScore, und drücken "OK". Wenn Ihr Browser
nicht öffnet, können Sie mittels copy/paste die URL in die Adresszeile
Ihres Browser kopieren.

6. MuseScore ist jetzt mit Ihrem Konto bei MuseScore.com verbunden

http://musescore.com/?utm_source=handbook
http://musescore.com/user/register?utm_source=handbook
http://musescore.com/user?utm_source=handbook
http://musescore.com/?utm_source=handbook
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Online speichern
Nach Ihrer ersten Anmeldung oder wenn Sie zu Datei → Online speichern...
gehen, fragt MuseScore Sie nach einigen Informationen über Ihre Partitur

1. Der Titel ist der Titel der Partitur. Sie können diesen ändern

2. Die Beschreibung wird neben Ihrer Partitur angezeigt werden.

3. Sie können wählen, ob die Partitur jeder Besucher von MuseScore.com
Ihre Partur zur Verfügung gestellt bekommen soll, oder ob sie privat
sein soll und nur Sie (und von Ihnen dazu eingeladene Gäste) sie sehen
können sollen.

4. Wählen Sie eine Lizenz. Durch Verwendung einer Creative Commons
Lizenz, erlauben Sie den Leuten Ihre Partitur mit bestimmten
Einschränkungen zu verwenden.

5. Sie können Markierungen hinzufügen, als Hilfe zum Auffinden Ihrer
Partitur auf MuseScore.com. Vergessen Sie nicht diese durch Komma
voneinander zu trennen.

Eine Partitur zu MuseScore.com hochladen
Sie können Partituren auch direkt zu MuseScore.com hochladen:

1. Klicken Sie auf den Upload link auf MuseScore.com

2. Hier haben Sie die gleichen Einstellmöglichkeiten, wie mit dem Datei →
Online speichern... Menü

3. Darüber hinaus haben Sie Zugriff auf weitere Informationen wie z.B.
Genre

Hinweis: Für den Fall, dass Sie Ihr Limit von 5 Partituren erreicht haben, 
können Sie immer noch über “Partituren direkt aus MuseScore heraus mit 
anderen teilen“ hochladen. Wenn Sie auch weiterhin über das Web 
hochladen möchten, müssten Sie zunächst ein Upgrade auf einem Pro

http://creativecommons.org
http://creativecommons.org
http://musescore.com/upload?utm_source=handbook
http://musescore.com/upgrade
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Account durchführen.

Eine Partitur auf MuseScore.com bearbeiten
Wenn Sie eine Ihrer Partituren auf MuseScore.com verändern wollen,
bearbeiten Sie die MuseScore Datei auf Ihrem Computer und führen die
folgenden Schritten aus:

1. Gehen Sie zur Partituren Seite auf MuseScore.com

2. Klicken Sie auf den “edit” Link

3. In dem Formular können Sie die Partitur Datei ändern, Sie können auch
alle Partitur Informationen, wie Titel, Beschreibung, etc. ändern.

http://musescore.com/upgrade
http://musescore.com/sheetmusic
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Kapitel 3

Notation

Im vorigen Kapitel "Grundlagen" haben Sie gelernt, wie die Noteneingabe
funktioniert und wie Sie mit der Werkzeugpalette umgehen. Das folgende
Kapitel "Notation" befasst sich mit unterschiedlichen Arten der Darstellung
von Noten in Ihrer Partitur und weiterführenden Details zu Fragen der
musikalischen Notation.

Versetzungszeichen (Akzidentien)
Versetzungszeichen (oder Akzidentien) werden solche Vorzeichen genannt,
die sich nicht am Anfang eines Abschnitts oder Stückes als
Tonartvorzeichnung befinden, sondern im Stück vor einzelnen Noten und
deren Tonhöhe beeinflussen, dazu gehören unter anderem beispielsweise
das Kreuz, das Be, sowie das Auflösungszeichen. Ein Versetzungszeichen gilt
für den Ton vor dem es steht für die restliche Dauer des Taktes, es kann aber
durch ein anderes Versetzungszeichen wieder aufgehoben werden.

Versetzungszeichen können durch Ziehen eines Versetzungszeichensymbols
von der Versetzungszeichenpalette auf eine Note gesetzt oder verändert
werden.

Wenn Sie nur die Tonhöhe einer Note verändern wollen können Sie auch die
Note selektieren und dann:
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• ↑ Erhöht die Note um einen Halbton, die Schreibweise mit Kreuzen wird
dabei bevorzugt.

• ↓ Erniedrigt die Note um einen Halbton, die Schreibweise mit B's wird
dabei bevorzugt.

• Strg+↑ Erhöht die Note um eine Oktave.

• Strg+↓ Erniedigt die Note um eine Oktave.

Ab Version 0.9.6 können Sie einem bestehenden Versetzungszeichen
Klammern hinzufügen, um es zu einer Warnakzidenzie zu machen. Ziehen
Sie hierzu das Klammersymbol aus der Versetzungszeichenpalette auf die
Akzidentie, die Sie einklammern möchten. Um die Klammern wieder zu
entfernen, markieren Sie das Versetzungszeichen und drücken Sie Delete.

MuseScore wählt automatisch die Position der Note und evtl. ein
Versetzungszeichen. Wenn Sie damit nicht einverstanden sind oder einfach
nur ein Sicherheitsvorzeichen setzen wollen, dann können Sie immer noch
manuell ein Vorzeichen aus der Vorzeichenpalette auf die Note ziehen und
die Automatik damit überstimmen. Wenn anschließend wieder die Tonhöhe
verändert wird, geht diese manuelle Wahl natürlich verloren.

Die Menüfunktion Noten → Versetzungszeichen neu berechnen versucht, die
Vorzeichen der gesamten Partitur neu zu berechnen.

Weblinks
• Versetzungszeichen auf de.wikipedia.org

Arpeggios

Notation
Ein Arpeggio wird meistens als eine gewellte vertikale Linie vor einem
Akkord notiert, es gibt aber auch andere Formen, ein Arpeggio darzustellen.

Erstellen
Arpeggios werden durch Ziehen eines Arpeggiosymbols aus der
Arpeggiotabelle auf einen Notenkopf eines Akkords gesetzt.

Ab Version 0.9.5 können Sie die Länge einer Arpeggiolinie ändern, indem Sie
einen Doppelklick darauf machen und die Markierung entsprechend
verschieben. Siehe auch Bearbeitungsmodus.

http://de.wikipedia.org/wiki/versetzungszeichen
http://de.wikipedia.org
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Weblinks
• Arpeggio auf de.wikipedia.org

Taktstriche

Taktstrichart ändern
Taktstriche werden per Drag&Drop aus der Taktstrich-Palette in die Partitur
eingefügt. Ziehen Sie hierzu mit der Maus die gewünschte Taktstrichart auf
einen Taktstrich in ihrer Partitur, um ihn zu ersetzen.

Um einen Taktstrich unsichtbar zu machen, klicken sie mit der rechten
Maustaste darauf und wählen sie Unsichtbar machen.

Systemübergreifende Taktstriche
Um Taktstriche zu verwenden, die sich über mehrere Notenzeilen
erstrecken, machen sie einen Doppelklick auf einen beliebigen Taktstrich um
seine Länge zu verändern (siehe Bearbeitungsmodus).

Klicken Sie auf die blaue Markierung und ziehen Sie sie zur
darunterliegenden Notenzeile. Sobald Sie den Bearbeitungsmodus verlassen
(z.B. per Mausklick auf eine freie Stelle in Ihrer Partitur) werden alle
Taktstriche Ihrer Partitur entsprechend angepasst.

http://de.wikipedia.org/wiki/arpeggio
http://de.wikipedia.org
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Siehe auch: Takte bearbeiten

Balken

Automatische Balken in MuseScore
Balken werden automatisch gesetzt. Diese Automatik kann mit manuell
gesetzten Hinweisen gesteuert werden. Ziehen Sie dazu das passende
Symbol von der Balken-Palette auf die Note, deren Balkenverhalten geändert
werden soll.

Sie können auch zuerst eine Note auswählen und dann auf das Balkensymbol
doppelklicken.

Beginnt einen Balken an dieser Note.
Ein Balken wird an dieser Note nicht beendet.
Diese Note soll nicht verbalkt werden.
Beginnt eine neue Balkenebene an dieser Note.

Siehe auch
• Systemübergreifende Balkung

Klammern

Entfernen
Wählen Sie die Klammer aus und drücken Sie Entf.

Einfügen
Ziehen Sie ein Klammersymbol aus der Klammern-Palette in den freien
Bereich des ersten Taktes in einem System.

Ändern
Ziehen Sie ein Klammersymbol aus der Klammern-Palette auf eine
bestehende Klammer in Ihrer Partitur.

Bearbeiten
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Mit einem Doppelklick auf eine Klammer kommen Sie in den
Bearbeitungsmodus. Sie können nun die Höhe der Klammer verändern um
die Klammer auf mehrere Notenzeilen zu erweitern.

Horizontale Position
Wenn Sie eine Klammer nach links oder rechts verschieben möchten,
machen Sie einen Doppelklick auf eine Klammer um in den
Bearbeitungsmodus zu gelangen und drücken Sie Umschalt⇑+← oder
Umschalt⇑+→ um sie nach links oder rechts zu bewegen.

Atemzeichen
Um ein Atemzeichen zu setzen, ziehen Sie es von der Atemzeichenpalette
auf eine Note der Partitur. Das Atemzeichen wird hinter der Note platziert.
Bis zur Version 0.9.5 werden Atemzeichen vor der Note platziert auf die Sie
gezogen werden.

Ein Atemzeichen in der Partitur:

Zäsuren werden auf die gleiche Weise gesetzt und sind ab Version 0.9.6
verfügbar.

Schlüssel
Durch Ziehen eines Schlüssels von der Schlüsselpalette auf einen Takt oder
einen Schlüssel der Partitur kann ein neuer Schlüssel erzeugt oder ein
vorhandener verändert werden. Verwenden Sie F9 (Mac: ⌥+⌘+K) um die
Palette anzuzeigen.
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Einfügen
Ziehen sie einen Schlüssel von einer Palette auf einen leeren Teil eines
Taktes. Dies erstellt einen Schlüssel am Anfang des Taktes. Wenn Sie einen
Schlüssel auf eine Note ziehen, erstellen Sie einen Schlüssel innerhalb eines
Takts. Schlüssel, die nicht am Zeilenanfang stehen werden kleiner
dargestellt.

Löschen
Wählen Sie einen Schlüssel aus und drücken Sie Entf.

Beachten Sie bitte, dass das Ändern oder Einfügen eines Schlüssels die
Tonhöhe der folgenden Noten unverändert lässt, Noten werden
entsprechend des neuen Schlüssels verschoben.

Schlagzeugnotation
Beispiel für Schlagzeugnotation:

Die Notation von Schlagzeug beinhaltet oft gleichzeitig vorkommende Noten
mit Hälsen nach oben und unten. Wenn Sie mit dem Erstellen von mehreren
Stimmen noch nicht so vertraut sind, erhalten Sie einen Überblick unter
Stimmen.
Die Besonderheiten zur Schlagzeugnotation können Sie im Folgenden
erfahren.

MIDI-Keyboard



30

Am einfachsten lassen sich Schlagzeugnoten mit einem MIDI-Keyboard
einfügen. Die meisten MIDI-Keyboards haben Schlagzeugsymbole über den
entsprechenden Tasten. Wenn Sie die Taste z.B. für die Hi-Hat drücken, wird
in MuseScore die richtige Note eingefügt werden. Dabei wird von
MuseScore automatisch auf die passende Richtung des Notenhalses und den
entsprechenden Notenkopf geachtet.

Computer-Tastatur
nur wenige Schlagzeuginstrumente:

• c für Bass-Drum

• d für Ride

Maus
Die Mauseingabe für Schlagzeuginstrumente ohne absolute Tonhöhen
funktioniert nicht so, wie man es von anderen Instrumenten kennt. Daher
hier die entsprechenden Schritte:

1. Wählen Sie eine Note oder Pause im Takt an. Bitte vergewissern Sie
sich, dass die Palette für Schlagzeug leer bleibt, bis Sie diesen Schritt
durchgeführt haben.

2. Drücken Sie "N", um zur Noteneingabe überzugehen

3. Wählen Sie die Notenlänge aus der Werkzeugleiste zur Noteneingabe
an

4. Wählen Sie in der Palette für Schlagzeug eine Note (wie z.B. Bass-Drum
oder Snare) an

5. Klicken Sie nun in den Schlagzeugtakt, um die Note einzufügen

Weblinks
• Video tutorial: Drum Parts (englisch)

Vorschlagsnoten
Ein kurzer Vorschlag (Acciaccatura) wird als kleine Note mit
durchgestrichenem Hals vor der sogenannten Hauptnote notiert. Ein langer
Vorschlag (Appoggiatura) ist nicht durchgestrichen.

Erstellen
Vorschlagsnoten werden durch Ziehen eines Symbols aus der
Vorschlagsnoten-Palette auf eine Hauptnote gesetzt. (Bis zur Version 0.9.5
hieß diese Palette nur „Noten”).

http://www.youtube.com/watch?v=kfj7v5s4akw
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Wenn Sie die Dauer einer Vorschlagsnote im Nachhinein ändern möchten,
klicken Sie auf die Vorschlagsnote, so dass sie ausgewählt ist, und wählen
Sie eine Tondauer aus der Symbolleiste oder per Tastaturkürzel (1 ... 9 (siehe
Noteneingabe).

Weblinks
• Kurzer Vorschlag und Langer Vorschlag auf de.wikipedia.org

Crescendo-Gabeln
Gabeln gehören zu den Linien-Objekten.

Für das Erzeugen einer Gabel muss zunächst eine Note ausgewählt werden,
um den Startpunkt zu markieren.

• H erzeugt eine Crescendo-Gabel

• Umsch+H erzeugt eine Diminuendo-Gabel (Decrescendo-Gabel)

Gabeln können auch durch Ziehen eines Gabelsymbols aus der Linienpalette
auf eine Note platziert werden.

H erzeugt eine Crescendo-Gabel:

Doppelclick schaltet in den Editier-Modus:

Umsch+rechts verschiebt den End-Anker:

rechts verschiebt den Endpunkt:

Tonart

http://de.wikipedia.org/wiki/verzierung_%28musik%29#kurzer_vorschlag
http://de.wikipedia.org/wiki/verzierung_%28musik%29#langer_vorschlag
http://de.wikipedia.org


32

Tonarten, bzw. die entsprechenden Vorzeichen, können gesetzt oder
verändert werden, indem ein Symbol aus der Tonartenpalette auf einen Takt
oder einen bereits bestehenden Satz von Vorzeichen in der Partitur gezogen
wird.

F9 zeigt das Palettenfenster.

Verändern
Ziehen Sie hierzu ein Tonartsymbol von der Tonartenpalette auf ein
bestehendes Tonartsymbol in Ihrer Partitur.

Zufügen
Ziehen ein Tonartsymbol von der Tonartenpalette auf einen leeren Teil eines
Taktes. Dies erzeugt einen Tonartwechsel am Anfang des Taktes.

Entfernen
Wählen Sie das Tonartsymbol in Ihrer Partitur aus, das Sie löschen möchten
und drücken Sie dann Entf.

Linien
Die Linienpalette funktioniert wie die anderen Paletten mit
"Drag-and-Drop" . Verwenden Sie die Maus, um Elemente aus der Palette auf
die Partitur zu ziehen und dort an der gewünschten Stelle abzulegen.

Ändern der Länge
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Wenn Sie mit Hilfe der Maus die Länge eines Linienelements ändern, bleibt
der Anker des Elements bestehen - das heißt, die Linie orientiert sich an
derselben Note. Wir empfehlen Ihnen die folgende Methode um Start- und
Endpunkte einer Linie zu verschieben:

1. Vergewissern Sie sich, dass sie sich nicht im Noteneingabe-Modus
befinden (Sie können den Modus mit N wechseln. Mit Esc verlassen Sie
den Noteneingabemodus).

2. Machen Sie einen Doppelklick auf das Linienelement, dessen Länge
oder Ankerpunkte Sie ändern möchten. Es erscheinen eine Start- und
eine Endmarkierung der Linie.

3. Wählen Sie mit der Maus per einfachem Klick eine der beiden
Markierungen aus

4. Bewegen Sie die Markierung mit den Pfeiltasten wie folgt

• ⇑Shift+← und

• ⇑Shift+→ um den Ankerpunkt um eine Note (bzw. einen Takt) zu
verschieben

5. Um die Markierungen zu verschieben, die Ankerpunkte aber
unverändert zu lassen, verwenden Sie nur die Pfeiltasten

• ← und

• → um die Markierungspunkte zu verschieben.

• Benutzen Sie Strg+Pfeiltasten für die Feinjustierung der Position.

See also: Crescendo-Gabeln, Volta (Wiederholung)

Ganztaktpausen

Ganztaktpausen

Wenn ein Takt keine Noten enthält wird eine Ganztaktpause verwendet.

Um eine Ganztaktpause zu erstellen, wählen Sie einen Takt aus und drücken
Sie Entf. Alle Noten und Pausen in diesem Takt werden entfernt und durch
eine Ganztaktpause ersetzt.

Mehrtaktpausen

Mehrtaktpausen werden üblicherweise in Einzelstimmen verwenden, um
eine längere Pause des Instruments anzuzeigen.
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Mehrtaktpausen verwenden

1. Wählen Sie im Menü Format → Format-Stilvorgaben bearbeiten...

2. Wählen Sie im Auswahlfeld auf der linken Seite „Partitur”

3. Aktivieren Sie „Mehrtaktpausen erstellen”

Einschränkungen
Die Format-Option wandelt automatisch alle leeren Bereiche der Partitur in
Mehrtaktpausen um. Aktivieren Sie diese Option deshalb erst, wenn Sie alle
Noten in der Partitur eingegeben haben.

Bis zur Version 0.9.5 fand kein automatischer Umbruch an bestimmten
Stellen wie doppelten Taktstrichen, Tonartwechseln oder
Probenmarkierungen statt. Dies wurde in neueren Versionen von MuseScore
behoben. Wie Sie dieses Problem umgehen können erfahren Sie im Abschnitt
„Mehrtaktpausen aufbrechen” im Kapitel Takte bearbeiten.

Wiederholungen
• Einfache Wiederholungen

• Volta

• Coda

Einfache Wiederholungen
Anfang und Ende einfacher Wiederholungen können durch Setzen
enprechender Taktstriche definiert werden.

Im letzen Takt einer Wiederholung kann unter "Eigenschaften" die Anzahl
der vorgesehenen Wiederholungen gesetzt werden. Soll eine Wiederholung
beim zweiten Mal etwas anders gespielt werden, so können die Varianten
mit einer Volta gekennzeichnet werden.

Sprünge
Sprünge bestehen im Allgemeinen aus drei Teilen:

• springe nach Marke

• spiele bis Marke

• weiter ab Marke

Marken sind Namen, die wir einer Taktposition geben. Zwei Sprungmarken
("Anfang", "Ende") bezeichnen den Anfang und das Ende eines Stückes und
müssen nicht speziell vereinbart werden.

Beispiele:
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Bei der Sprunganweisung Da Capo springt die Wiedergabe an den Anfang
und spielt das gesamte Stück noch einmal (bis zur impliziten Ende-Marke).

Bei der Sprunganweisung Da Capo al Fine springt die Wiedergabe an den
Anfang, um dann bis zur Marke Fine zu spielen.

Dal Segno al Fine (oder D.S. al Fine) springt zur Segno-Marke und spielt
dann bis zur Marke Fine

Dal Segno al Coda springt zur Segno-Marke und spielt dann bis zur ersten
Coda-Marke. Das Spiel wird dann an der zweiten Coda-Marke fortgesetzt.
Die Eigenschaften der Sprünge werden per Rechtsklick an der D.S. al
Coda-Marke eingestellt.

Siehe auch: Volta

Weblinks
• Video tutorial: Codas (englisch)

Bindebögen
Ein Bindebogen ist eine gebogene Linie, die zwei oder mehrere Noten
überspannt, und wird üblicherweise verwendet um anzuzeigen, dass die
Noten unter dem Bogen gebunden gespielt werden sollen. Wenn Sie zwei
Noten derselben Tonhöhe verbinden möchten, siehe Haltebogen.

Erstellung
1. Verlassen Sie den [[Noteneingabemodus] und wählen Sie die erste Note

aus:

2. Erstellen Sie einen Bogen mit S:

3. Umschalt⇑+→ bewegt das Ende des Bogens zur nächsten Note:

4. Mit X können wählen ob der Bogen über oder unter den Noten 
erscheinen soll:

http://www.youtube.com/watch?v=04xta6irzgg
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5. Esc beendet den Bogen-Bearbeitungsmodus:

Anpassungen
Im Bearbeitungsmodus erscheinen sogenannte „Anfasser”, Sie können sie
mit der Maus verschieben. Die beiden äußeren Anfasser bestimmen Start-
und Endpunkt des Bogens, mit den beiden inneren können Sie die Höhe des
Bogens verändern.

Ein Bogen kann mehrere Systeme oder sogar Seiten überspannen. Der Start-
und Endpunkt eines Bogens ist jeweils an einer Note verankert. Wenn Noten
wegen Änderungen im Layout ihre Position in der Partitur ändern, werden
Bögen mitbewegt und die Größe angepasst.

Diese Beispiel zeigt einen Bindebogen, der vom Bass- zum Violinschlüssel
reicht. Selektieren Sie die erste Note mit dem Maus, drücken die Strg Taste,
wählen die letzte Note für den Bindebogen und drücken S, um diesen
hinzuzufügen.

Anmerkung: Es ist nicht möglich, den Ankerpunkt eines Bogens mit der
Maus zu verändern. Verwenden Sie Umschalt⇑ + ← oder → die Ankerpunkte für
Bogenbeginn und -ende festzulegen.

Gestrichelte Bögen
Gestrichelte Bögen werden oft in Liedern mit mehreren Strophen verwendet,
um Unterschiede in der Silbenverteilung der einzelnen Strophen anzuzeigen.
Gestrichelte Bögen können außerdem auf Vorschläge eines Herausgebers
zurückgehen (um eine unterscheidbare Darstellung zur
Originalbogensetzung des Komponisten zu ermöglichen). Um einen Bogen
gestrichelt darzustellen, machen Sie einen Rechtsklick auf den Bogen und
wählen Sie Eigenschaften Bindebogen.... Es erscheint ein Dialogfenster, in dem
Sie die gewünschte Darstellung wählen können.
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See also: Haltebogen, Bearbeitungsmodus.

Haltebögen
Ein Haltebogen ist eine gebogene Linie zwischen zwei Noten der selben
Tonhöhe. Wenn Sie einen Bogen erstellen möchten, der sich über mehrere
Noten erstreckt, siehe Bindebögen.

Erste Methode
Wählen Sie die erste von zwei aufeinanderfolgenden Noten mit der selben
Tonhöhe aus

Mit + erstellen Sie einen Haltebogen:

Zweite Methode
Um im Noteneingabemodus einen Haltebogen zu erstellen, drücken Sie +
nachdem Sie die erste Note eingegeben haben.

Taktangaben
Taktangaben finden Sie in der Palette. Sie können eine Taktangabe auf Ihre
Partitur ziehen und an der gewünschte Stelle ablegen (siehe Palette für eine
Beschreibung der Werkzeugpalette in MuseScore).

Wenn Sie eine Taktangabe in der Palette nicht finden können, öffnen Sie im
Menü Einfügen → Taktarten... um Ihre eigene Taktangabe zu erstellen. Sie
können die obere und untere Zahlenangabe auf der rechten Seite wählen.

In den meisten Fällen werden Sie nur die erste der oberen Zahl ändern 
müssen. Die weiteren Angaben werden für zusammengesetzte Takte 
benötigt, bei diesen werden mehrere obere Zahlen mit einem Pluszeichen
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verbunden.

Auftakte
Es gibt Situationen bei denen die tatsächliche Dauer eines Taktes nicht der
Taktangabe entspricht. Ein häufiges Beispiel dafür ist ein Auftakt. Wie Sie
die effektive Dauer eines Taktes ändern (hierbei wird keine Taktwechsel
angezeigt), Sie unter Takte bearbeiten im Abschnitt Eigenschaften
nachlesen.

Tremolo
Mit Tremolo wird eine schnelle Wiederholung von Noten bezeichnet. Es wird
durch ein bis drei schräge Balken am Notenhals einer Note oder beim
Zwei-Noten-Tremolo zwischen den Noten dargestellt.

Für Ein- und Zwei-Noten-Tremoli gibt es jeweils getrennte Symbole in der
Tremolopalette.

Bei einem Zwei-Noten-Tremolo hat jede Note den Wert der gesamten Dauer
des Tremolo. Für ein Tremolo mit der Dauer einer halben Note müssen sie
zunächst jedoch zwei Viertelnoten eingeben. Nach dem Ziehen des
Tremolosymbols auf die erste Note werden die Notenwerte automatisch
verdoppelt.

N-tolen (Triolen)
N-tolen werden verwendet, wenn übergeordnete Notenwerte anders als 
durch die Taktart vorgegeben in nächstkleinere Notenwerte geteilt werden 
sollen. Eine Triole in einem gerade Takt beispielsweise teilt den 
nächstgrößeren Notenwert in 3 statt 2 Teile. Beispiele für N-tolen sind: 
Duole, Triole, Quintole. 
N-tolen werden als kleine Ziffer unter oder über einer Gruppe von Noten
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notiert, wahlweise durch eckige Klammern gekennzeichnet.

Erstellen
Wenn Sie eine Triole eingeben möchten, erstellen Sie zunächst eine Note
mit der Gesamtdauer der Triole. Beispielsweise hat eine Triolengruppe von
Achtelnoten eine Gesamtdauer einer Viertelnote

Markieren Sie diese Note und wählen Sie aus dem Menü Noten → N-tolen →
Triole. Die Ausgewählte Note wird in eine Triole umgewandelt, die aus drei
Noten des nächstkleineren Notenwerts besteht.

die weiter bearbeitet werden kann

Noteneingabemodus
Im Noteneingabemodus funktioniert die Eingabe von Triolen etwas anders.
Ab Version 0.9.5 müssen Sie erst die gewünschte Länge, dann die Tonhöhen
eingeben.

1. Starten Sie den Noteneingabemodus mit N

2. Vergewissern Sie sich, dass sich die Eingabemarkierung an der Stelle
befindet, wo Sie die Triole eingeben möchten (Sie können die
Markierung mit den Pfeiltasten bewegen)

3. Wählen Sie Viertelnoten als Tondauer aus. Klicken Sie hierzu auf die
Viertelnote in der Symbolleiste, oder drücken Sie 5

4. Erstellen Sie eine Triole. Klicken Sie hierzu im Menü auf Noten → N-tolen
→ Triolen, oder drücken Sie Ctrl+3 (Mac: ⌘+3)

5. Beachten Sie, dass automatisch Achtelnoten zur Eingabe ausgewählt
wurden. Geben Sie nun Noten ein

Eigenschaften
Um das Aussehen einer N-tole zu ändern, klicken Sie mit der rechten 
Maustaste darauf und wählen Sie Eigenschaften N-tole....
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Im Auswahlfeld „Nummer” können Sie wählen, ob die N-tole Sie eine Zahl,
ein Verhältnis, oder keine Bezeichnung tragen soll.

Die Auswahl Klammer, gibt Ihnen die Möglichkeit das Anzeigen einer
Klammer mit „Klammer” oder „keine” selbst einzustellen. Wenn Sie
„automatisch” wählen, wird bei N-tupeln, die Noten ohne Balken enthalten,
eine Klammer angezeigt, sonst nicht.

Weblinks
• Triole auf de.wikipedia.org

• How To Create Triplets in MuseScore [video] (englisch)

Stimmen
Stimmen werden benötigt, wenn in einer Notenzeile mehrere Noten
Übereinander stehen sollen, die unterschiedliche Längen haben. Bis zu vier
Stimmen können in unabhängigen Rhythmen in einer Zeile notiert werden.

Vorgehensweise
1. Beginnen Sie mit der Eingabe der obersten Stimme (das sind alle

Noten, deren Hälse später nach oben zeigen sollen)

2. Bei der Eingabe können die Notenhälse noch nach unten zeigen, ab der
Version 0.9.4 ändert MuseScore dies automatisch, sobald eine zweite

Stimme dazukommt. 
3. Wenn Sie Noten anstelle der Maus mithilfe der Tastatur oder eines 

MIDI-Keyboards eingeben, bewegen Sie die Eingabemarke mit dem 
Linkspfeil auf ihrer Tastatur, um zum Anfang der Notenzeile

http://de.wikipedia.org/wiki/triole_%28musik%29#triole
http://de.wikipedia.org
http://www.musescoretips.com/2011/02/how-to-create-triplets-in-musescore-video/
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zurückzukehren.

4. Wählen Sie per Klick auf "2"  in der Symbolleiste (oder Strg+I Strg+2
auf der Tastatur) den Eingabemodus für die zweite Stimme

5. Geben Sie die Noten für die untere Stimme ein

6. Nachdem Sie alle Noten eingegeben haben, sollte ihre Notenzeile wie
folgt aussehen:

Wann Stimmen benötigt werden
• Wenn Sie in einem Akkords innerhalb einer Notenzeile Noten mit Hälsen

in unterschiedlicher Richtung benötigen

• Wenn mehrere Noten gleichzeitig in einer Notenzeile mit
unterschiedlichen Rhythmen dargestellt werden sollen, dies gilt für alle
Töne die gleichzeitig erklingen, aber unterschiedliche Längen haben
ebenso wie Pausen die über oder unter anderen gleichzeitig
erklingenden Noten notiert werden sollen

Versteckte Pausen (Platzhalter)
Um eine Pause zu verstecken, machen Sie einen Rechtsklick auf die Pause
und wählen Sie Unsichtbar machen. Wenn Sie Ansicht → Unsichtbares anzeigen
aktiviert haben, sehen Sie versteckte Pausen weiterhin grau eingefärbt.
Beim Drucken werden versteckte Pausen nicht ausgegeben.

Volta
Soll in einer Wiederholung beim zweiten mal das Ende etwas anders gespielt
werden, dann verwendet man die normalen Wiederholungszeichen und
kennzeichnet die beider Endvarianten mit Klammern:

Die Klammern können auch mehr als einen Takt überspannen. Durch
Doppelclick auf eine Klammer kommen wir in den Bearbeitungsmodus und
können die Anfasser mit den Kommandos

• Umsch+Rechts um einen Takt nach rechts

• Umsch+Links um einen Takt nach links

verschieben. Durch diese Kommandos wird das "logische" Ende bzw. der 
Anfang verschoben, die bestimmen, welche Takte die Volta umklammert.
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Andere Kommandos im Bearbeitungsmodus verschieben die Anfasser auch,
haben jedoch keine Auswirkungen bei der Wiedergabe der Wiederholungen
sondern wirken nur optisch. Wird der Anfang oder das Ende einer
Voltaklammer verschoben, dann zeigt eine gestrichelte Linie von der
logischen Voltaposition zur aktuellen Position.

Eigenschaften

Wiederholungsliste
In der Wiederholungsliste wird angegeben, in welcher Wiederholung die
Volta gespielt werden soll. Gibt es mehrere Wiederholungen und soll die
Volta in mehreren Wiederholungen gespielt werden, dann müssen sie einzeln
per Komma getrennt aufgeführt werden.

Text
Über den Eigenschaften Dialog läßt sich ein beliebiger Text für die Volta
einstellen. Der Text sollte natürlich mit der Liste der Wiederholungen
korrespondieren.

Weblinks
• Vidoe tutorial: Repeats, 1st and 2nd time endings (englisch mit

deutschen Untertiteln)

http://www.youtube.com/watch?v=uivmxhlpopa4
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Kapitel 4

Sound und Wiedergabe

MuseScore unterstützt die Audo-Wiedergabe von Partituren und das
Abspielen von Noten bei der Eingabe. Dieses Kapitel beschreibt die
Benutzung der Wiedergabe-Funktionen und die Erweiterung von MuseScore
um zusätzliche Instrumentenklänge (SoundFonts).

Wiedergabemodus
MuseScore besitzt einen integrierten Sequenzer sowie einen Synthesizer, um
die Partitur wiedergeben zu können.

Durch Drücken des Wiedergabe-Buttons  wird der Wiedergabemodus
gestartet. Im Wiedergabemodus sind die folgenden Befehle verfügbar:

• Leertaste Start/Stop

• ← zum vorherigen Akkord

• → zum nächsten Akkord

• Strg+← zum vorherigen Takt

• Strg+→ zum nächsten Takt

• Pos1 zurück zum Anfang

• F11 zeigt das Wiedergabepult

Durch wiederholtes Drücken des Wiedergabe-Buttons  verlassen Sie den
Wiedergabemodus wieder.

MuseScore nimmt die Wiedergabe an der Stelle wieder auf, an der Sie
angehalten haben. Wenn Sie eine Note in Ihrer Partitur auswählen, startet
MuseScore beim nächsten Mal die Wiedergabe von dort. In der Symbolleiste
finden Sie außerdem einen Button, um zum Anfang der Partitur
zurückzuspringen.
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Um auch die Wiederholungen bei der Wiedergabe abzuspielen, aktivieren Sie

den  Wiederholungen ein-/ausschalten-Button.

Wiedergabepult
Das Wiedergabepult bietet Ihnen weitere Einstellungen vorzunehmen, wie
zum Beispiel die Wiedergabegeschwindigkeit, die Startposition und die
Wiedergabelautstärke. Sie finden es auch im Menu unter Ansicht →
Wiedergabepult.

Fehlerdiagnose
Version 0.9.5 oder frühere: Wenn Sie andere Instrumente für die
Wiedergabe verwenden möchten als das voreingestellte Klavier, müssen Sie
den eingestellten SoundFont unter Bearbeiten → Einstellungen... → I/O ändern.
Mehr können Sie darüber im Kapitel SoundFont erfahren.

Ubuntu und Sound
Wenn Sie Schwierigkeiten mit der Wiedergabe auf einem Ubuntu-System
haben, empfehlen wir Ihnen mindestens die MuseScore-Version 0.9.5 oder
eine neuere zu verwenden – siehe hierzu die Download-Seite auf
musescore.org. Bei Fragen oder Problemen wenden Sie sich bitte an das
Support-Forum auf musescore.org.

SoundFont
Ihre MuseScore-Installation beinhaltet einen SoundFont, das ist eine Datei,
die Wiedergabe-Klänge für jedes Instrument enthält. Es gibt SoundFont
speziell für die Wiedergabe von klassischer Musik, Jazz oder Pop-Musik,
SoundFont können sich erheblich Größenunterschiede aufweisen. Neuere
MuseScore-Versionen (ab 0.9.6) enthalten einen kleinen
Allzweck-SoundFont, Sie finden Ihn in der Datei "TimGM6mb.sf2".

Überblick
Eine SoundFont-Datei kann Klänge für eine beliebige Anzahl von 
Instumenten enthalten. Es gibt im Internet zahllose frei verfügbare 
SoundFonts. Wenn Sie einen davon ausprobieren möchten, empfiehlt es sich, 
einen SoundFont zu verwenden der die 128 Instrumente nach dem General

http://en.wikipedia.org/wiki/general_midi
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MIDI-Standard (GM) abdeckt. Andernfalls werden Ihre Dateien unter
Umständen nicht mit den richtigen Instrumenten abgespielt, wenn Sie auf
einem anderen Rechner abspielen.

Die Dateigrößen und die Klangqualität von SoundFonts, die Sie im Internet
finden, sind sehr unterschiedlich. Als Faustregel können Sie davon
ausgehen, dass größere SoundFonts auch eine bessere Qualität mit sich
bringen. Es kann allerdings sein, dass eine zu große SoundFont-Datei auf
Ihrem System nicht funktioniert. Wenn Ihnen MuseScore nach der
Installation eines neuen SoundFonts zu langsam vorkommt, oder die
Wiedergabe von Partituren nicht reibungsfrei läuft, versuchen Sie es mit
einem kleineren SoundFont. Im folgenden sind drei verbreitete SoundFonts
unterschiedlicher Größe beschrieben:

• FluidR3_GM.sf2 (141 MB unkomprimiert), download
Fluid-soundfont.tar.gz (129 MB)

• MagicSF_ver2.sf2 (67.8 MB unkomprimiert), hierzu Big SoundFonts
(englisch)

• TimGM6mb.sf2 (5.7 MB unkomprimiert), download modified
TimGM6mb.sf2 (Mit freundlicher Genehmigung von Tim Brechbill)

Komprimierung
SoundFont-Dateien können sehr groß sein und werden deswegen
üblicherweise in komprimierter Form zum Download angeboten, erkennbar
unter anderen an den Dateiendungen .zip, .sfArk, oder .tar.gz. Diese Dateien
müssen vor ihrer Verwendung erst entpackt werden.

• ZIP ist ein Standard-Komprimierungsformat das auf den meisten
Betriebssystemen verfügbar ist.

• sfArk ist ein Format, das speziell für die Komprimierung von SoundFonts
entwickelt wurde. Verwenden Sie zum Dekomprimieren bitte die
sfArk-Software.

• .tar.gz ist ein in der Linux/Unix-Welt verbreitetes
Komprimierungsformat. Windows-Benutzer können das freie 7-zip zum
entpacken verwenden, das auch die meisten anderen gängigen
Komprimierungsformate unterstützt. In diesem Fall beachten Sie bitte,
dass ein .tar.gz-Archiv zweimal entpackt werden muss (GZip und TAR).

MuseScore-Einstellungen
Nachdem Sie einen SoundFont heruntergeladen und entpackt haben,
müssen Sie ihn in MuseScore einbinden. Speichern Sie den SoundFont in
einem Ordner Ihrer Wahl und nehmen Sie die folgenden Einstellungen in
MuseScore vor:

Go to Ansicht → Synthesizer. Der eingestellte Pfad zur voreingestellten 
SoundFont-Datei hängt vom Betriebssystem ab und sieht in etwa wie folgt

http://en.wikipedia.org/wiki/general_midi
http://www.musescore.org/download/fluid-soundfont.tar.gz
http://www.personalcopy.com/sfarkfonts1.htm
http://mscore.svn.sourceforge.net/viewvc/mscore/trunk/mscore/share/sound/timgm6mb.sf2
http://mscore.svn.sourceforge.net/viewvc/mscore/trunk/mscore/share/sound/timgm6mb.sf2
http://ocmnet.com/saxguru/timidity.htm#sf2
http://www.melodymachine.com/sfark.htm
http://www.7-zip.org/
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aus:

• Windows: C:/Programme/MuseScore//sound/TimGM6mb.sf2

• Windows (64-bit): C:/Programme
(x86)/MuseScore//sound/TimGM6mb.sf2

• Mac OS X:
/Applications/MuseScore.app/Contents/Resources/sound/TimGM6mb.sf2

• Linux (Ubuntu): /usr/share/sounds/sf2/TimGM6mb.sf2

Klicken Sie auf das "Öffnen"-Symbol neben dem Eingabefeld für den
SoundFont-Pfad und navigieren Sie zu dem Ordner, der Ihre
SoundFont-Datei (.sf2) enthält. Wählen Sie Ihre Datei aus und drücken Sie
"Öffnen".

MuseScore 0.9.5 oder älter
Wenn Sie Version 0.9.5 oder eine ältere benutzen, öffnen Sie im Dialog
Bearbeiten → Einstellungen... den Reiter I/O.

Der voreingestellte SoundFont ist :/data/piano1.sf2. Ersetzen Sie ihn
durch den Pfad zu Ihrer neuen SoundFont-Datei (.sf2). Klicken Sie dazu auf
das "Öffnen"-Symbol, navigieren Sie zu ihrer Datei und öffnen Sie sie.

Klicken Sie auf "OK" um Ihre Änderungen zu übernehmen und verlassen Sie
die Einstellungen. Anschließend müssen Sie MuseScore neu starten, damit
der neue SoundFont geladen wird.

Fehlerdiagnose
Wenn die Wiedergabe-Werkzeuge-Leiste in Ihrer Symbolleiste grau und
deaktiviert oder nicht sichtbar ist, versuchen Sie den folgenden Ansatz, um
die Audio-Wiedergabe wieder zu reparieren.

1. Vergewissern Sie sich, dass im Menü Ansicht → Wiedergabe markiert ist.
Wenn nicht, klicken Sie ihn an, so dass die Auswahlmarkierung
erscheint. Wenn das Problem mit der Wiedergabesymbolleiste weiterhin
besteht, versuchen Sie den nächsten Schritt;

Wenn die Wiedergabesymbolleiste nach der Änderung des SoundFonts
verschwindet, öffnen Sie im Dialog unter Edit → Preferences... den Reiter I/O
und klicken Sie auf OK, ohne weitere Änderungen vorzunehmen. Nach
einem Neustart von MuseScore sollte die Wiedergabesymbolleiste
wieder erscheinen. Es handelt sich hierbei um einen bekannten Fehler in
der MuseScore 0.9.3 und in früheren Versionen.
Wenn Sie zum ersten Mal den Soundfont ändern, verwenden Sie bitte
zunächst einen der obengenannten.

Tempo
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Sie können die Wiedergabegeschwindigkeit über das Wiedergabepult
verändern oder über einen Tempotext darauf Einfluss nehmen.

Das Wiedergabepult
• Wiedergabepult anzeigen: Ansicht → Wiedergabepult

• Bewegen Sie den Tempo-Schieberegler um die
Wiedergabegeschwindigkeit (BPM) zu verändern.

Tempotext
• Wählen Sie eine Note aus, über der der Tempotext erscheinen soll

• Rufen Sie im Menü <Einfügen → Text... → Tempo... auf

• Wählen Sie einen Voreingestellten Tempotext aus, oder geben Sie eine
eigene Bezeichnung ein und passen Sie die Wiedergabegeschwindigkeit
(BPM) an.

• Drücken Sie OK um das Dialogfenster zu verlassen.

Bestehender Tempotext kann verändert werden, indem sie per Doppelklick
auf ein Textelement in den Bearbeitungsmodus wechseln. Im
Bearbeitungsmodus können Sie mit F2 die Textsymbolpalette aufrufen um
Notensymbole (beispielsweise für Metronombezeichnungen) in den
Tempotext einzufügen.

Die Wiedergabegeschwindigkeit (BPM) eines Tempotextes können Sie
nachträglich verändern, indem Sie darauf rechtsklicken und Eigenschaften
Tempotext... aufrufen.

Beachten Sie bitte: die Tatsächliche Wiedergabegeschwindigkeit kann
schneller oder langsamer als der eingestellte Wert Ihres Tempotextes sein,
wenn die Wiedergabegeschwidigkeit im Wiedergabepult nicht auf 100%
gesetzt ist.

Instrumente und Klang ändern und anpassen

Mischpult
Das Mischpult (Mixer) dient dazu Instrumente, die den einzelnen
Notenzeilen zugeordnet sind, zu ändern. Hier kann auch Lautstärke (Vol),
Links-Rechts-Balance (Pan), Hall (Reverb), Klang-Vervielfachung (Chorus)
für jede Notenzeile verändert werden. Um das Mischpult einzublenden,
wählen Sie aus dem Hauptmenü Ansicht → Mischpult .
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Stummschaltung und Solo
Mit dem Stumm-Markierfeld kann eine ganze Notenzeile auf stumm
geschaltet werden. Umgekehrt dient das Solo-Markierfeld dazu, alle
Notenzeilen auf stumm zu schalten außer derjenigen Notenziele, die als
"Solo" markiert wurde.

Zeigerskalen
Klicken Sie auf die Zeigerskalen und ziehen die Maus nach oben, um eine
Skala im Uhrzeigersinn zu drehen. Klicken und ziehen Sie nach unten, um im
Gegenuhrzeigersinn zu drehen.

Instrumente/Sound
Das Drop-Down-Menü unter "Sound:" listet jedes verfügbare Instrument auf.
Die verfügbaren Instrumente hängen vom installierten SoundFont ab. Diese
Eigenschaft ist erst ab MuseScore Version für Windows 0.9.5 oder später
verfügbar.

Klangwechsel im Stück
In MuseScore können einige Instrumente mitten im Stück den Klang ändern.
Zum Beispiel können Saiteninstrumente von gestrichen zu gezupft (pizzicato)
wechseln oder ein Tremolo aufweisen; Trompeten können zu gedämpfter
Spielweise (gestopft) wechseln. Das folgende Beispiel erzeugt einen Teil mit
gedämpften Trompetenklang, aber die gleiche Vorgehensweise gilt für
Pizzicato- oder Tremolo-Teile.

1. Markiere die erste Note des gedämpften Teils

2. Wählen Sie aus dem Hauptmenü Erzeugen → Text → Takt gebundener Text

3. Schreibe Mute (oder eine äquivalenten Ausdruck wie Con Sordino). Dieser
Text dient nur dem angezeigten Notenblatt und hat keinen Einfluss auf
die Tonerzeugung in MuseScore

4. Rechts-Klicken Sie auf die eben erzeugte Text-Box Eigenschaften
Notenzeilentext...

5. Im erscheinenden Dialogkasten markieren Sie das Kanal Kästchen

6. Im gleichen Dialogfeld markieren Sie das mute Kästchen

7. Klicken Sie auf OK, um die Eingabe abzuschliessen und zur Partitur
zurückzukehren

Jede Note, welche nach einer so bearbeiteten Note eingegeben wird, wird in
MuseScore ebenfalls gedämpft wiedergegeben. Um wieder zu einem
ungedäpften Klang zurückzukehren, befolgen Sie obige Vorgehensweise,
aber schreiben Offen in Schritt 3 und wählen Normal in Schritt 6.



49

Lautstärke
Die Wiedergabelautstärke kann entweder für das ganze Stück im
Wiedergabepult geändert werden oder lokal mit Hilfe von Dynamiktexten in
der Partitur.

Wiedergabepult
• Wiedergabepult anzeigen: Ansicht → Play Wiedergabepult

• Ändern der Lautstärke mit den Schiebern

Dynamiktext
Aus der Dynamikpalette auf einen Dynamiktext klicken und ihn auf einen
Takt der Partitur ziehen.

Wiedergabelautstärke für einen Dynamiktext einstellen

• Rechts-Klick auf den Dynamiktext, um das Menü zu öffnen.

• "MIDI Properties" auswählen.

• Die "Anschlag" Zahl verändern, höhere Werte für lazter, niedrigere für
leiser.

Weblinks
• Video tutorial: Lyrics, Copying & Dynamics

http://www.youtube.com/watch?v=e55-ynhsk-s
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Kapitel 5

Text

Im vorangegangenen Kapitel wurde bereits die Erstellung von Text mit
Einfluss auf die Wiedergabegeschwindigkeit besprochen, es gibt aber noch
verschiedene weitere Texttypen in MuseScore: Liedtext,
Akkordbezeichnungen, Dynamikbezeichnungen, Fingersatz, Überschriften
und viele andere. Die verschiedenen Textarten werden im Hauptmenü über
Erstellen → Text aufgerufen.

Für kurzen Text ohne weitere Funktionen verwenden Sie am besten
Notenzeilen- oder Systemtext. Beide Arten unterscheiden sich darin, ob der
Text für nur eine Notenzeile oder das ganze System gültig sein soll.

Text bearbeiten
Ein Doppelklick auf einen Text startet den Bearbeitungsmodus:

Im Bearbeitungsmodus stehen die folgenden Befehle zur Verfügung:

• Strg+B (Mac: ⌘+B) Fettschrift ein/aus

• Strg+I (Mac: ⌘+I) Kursivschrift ein/aus

• Strg+U (Mac: ⌘+U) Unterstreichen ein/aus

• Cursor bewegen: Pos1 Ende ← →

• Backspace löscht Zeichen links vom Cursor

• Entf löscht Zeichen rechts vom Cursor

• Eingabetaste neue Zeile beginnen

• F2 Zeigt die Textsymbolpalette (siehe unten)
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Symbole und Sonderzeichen
Sie können Viertelnoten, Brüche, und andere Sonderzeichen als Symbole in
Ihren Text einfügen. In der Textpalette klicken Sie auf das Tastatursymbol

 um die Textsymbolpalette zu öffnen

Bestehenden Text bearbeiten
Änderungen an Format-Stilvorgaben haben keinen Einfluss auf bereits
existierenden Text. Um die Formatierung von Liedtext zu ändern, machen
Sie einen Rechtsklick auf eine Silbe, wählen Sie „Texteigenschaften” und
ändern Sie die Formatierung. Um die Änderungen für den gesamten Liedtext
zu übernehmen, aktivieren Sie die Option „auf alle Elemente gleichen Typs
anwenden”. Beachten Sie, dass dies nicht für Akkordbezeichnungen
funktioniert..

Siehe auch: Akkordbezeichnungen, Liedtext, Rahmen, Bearbeitungsmodus

Textstile
Der Textstil bestimmt das aussehen eines Textes bei seiner Erstellung

Textformat:
• Font: Name der Schriftart, beispielsweise "Times New Roman" oder

"Arial"

• Größe: Schriftgröße in Punkten

• Kursiv, Fett, Unterstrichen: Schrifteigenschaften

• Anker: Seite, Zählzeit, Note, Notenzeile, System

• Ausrichtung: Horizontal: links, rechts, zentriert; Vertikal: oben, unten,
zentriert

• Offset: Relative Position (Entfernung) zum Anker

• Offset Typ: mm, space, oder Prozent der Seitengröße

Texttypen:



52

• Titel, Untertitel, Urheber (Musik), Urheber (Text): Diese Texttypen
sind an der Seite verankert.

• Fingersatz: Fingersätze haben ihren Ankerpunkt an der dazugehörigen
Note.

• Liedtext: Liedtext wird an einer Zählzeit verankert.

• Akkordbezeichnungen: Akkordbezeichnungen werden ebenfalls an
einer Zählzeit verankert.

• Akkolade: Bezieht sich auf alle Notenzeilen die sich in der Akkolade
befinden.* Verankert an einer Zählzeit.

• Notenzeile: Bezieht sich auf eine einzelne Notenzeile innerhalb einer
Akkolade.* Verankert an einer Zählzeit.

* Die Unterscheidung zwischen Akkoladentext und Notenzeilentext ist
wichtig für eine Partitur mit mehreren Einzelstimmen. Akkoladentext findet
sich in allen Einzelstimmen wieder, Notenzeilentext nur in der
dazugehörigen Einzelstimme.

Akkordbezeichnungen
Akkordbezeichnungen können eingegeben werden, indem Sie eine Note
auswählen und Strg+K drücken. Damit erstellen Sie eine Akkordbezeichnung
über dem ausgewählten Akkord.

• Drücken Sie die Leertaste um zum nächsten Akkord zu springen.

• Umschalt⇑+Leertaste zum vorhergehenden Akkord.

• Strg+Space Fügt ein Leerzeichen zur Akkordbezeichnung hinzu.

Akkordbezeichnungen können als normaler Text eingegeben werden. Um ein
Kreuz einzüfugen, verwenden Sie #, für ein b b. Diese Zeichen werden
automatisch durch Vorzeichen und Kreuze ersetzt, wenn Sie zum nächsten
Akkord springen.

Jazz-Font
Wenn Sie eine der Handschrift ähnlicheren Darstellung bevorzugen, können
Sie ab Version 0.9.5 einen Jazz-Font auswählen.

1. Öffnen Sie im Menü Format → Format-Stilvorgaben bearbeiten...

2. Wählen Sie im Auswahlfeld auf der linken Seite Akkordbezeichnungen

3. Klicken Sie auf der rechten Seite neben dem Eingabefeld
(„stdchords.xml”) auf das Symbol und öffnen Sie die Datei jazzchords.xml
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Fingersatz
Um einen Fingersatz zu notieren, wird das entsprechende Symbol aus der
Fingersatzpalette auf einen Notenkopf in der Partitur gezogen. Wenn Sie
zuerst einen Notenkopf markieren, kann der Fingersatz mit einem
Doppelklick hinzugefügt werden. Der Fingersatz kann wie normaler Text
bearbeitet werden.

Liedtext
1. Geben Sie zuerst alle Noten ein.

2. Wählen Sie die erste Note aus.

3. Wählen Sie im Menü Einfügen → Text → Liedtext, und geben die den
Liedtext für die erste Note ein.

4. Drücken Sie die Leertaste am Ende eines Wortes um zur nächsten Note
zu gelangen.

5. Durch Drücken von - am Ende eine Silbe gelangen Sie ebenfalls zur
nächsten Note, die Silben werden durch einen Bindestrich verbunden.

6. Umschalt+Leertaste positioniert auf die vorherige Note (Silbe).

7. Mit der Eingabetaste (Mac: Return) gelangen Sie zur darunterliegenden
Liedtextzeile für die nächste Strophe.

Soll eine Silbe über mehrere Noten gesungen werden, so wird dies mit 
einem Unterstrich angezeigt:
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Der Text wird mit soul, _ _ _ To Esc erzeugt.

Sonderzeichen
Liedtext kann wie normaler Text eingegeben werden mit ein paar
Ausnahmen. Wenn Sie ein Leerzeichen, einen Bindestrich oder einen
Unterstrich innerhalb einer Silbe eingeben möchten, verwenden Sie die
folgenden Tastaturkürzel.

• Strg+Leertaste (Mac: ⌥+Leertaste) fügt ein Leerzeichen in den Liedtext ein

• Strg+- (Mac: ⌥+-) fügt einen Bindestrich (-) in den Liedtext ein

• Strg+_ (Mac: ⌥+_) fügt einen Unterstrich (_) in den Liedtext ein

Siehe auch: Text bearbeiten, Akkordbezeichnungen.

Weblinks
• Video tutorial: Lyrics, Copying & Dynamics (englisch)

http://www.youtube.com/watch?v=e55-ynhsk-s
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Kapitel 6

Formatierung

Umbrüche
Seiten- oder Zeilenumbrüche (system breaks) können durch Ziehen eines
entsprechenden Symbols aus der Umbruchpalette auf eine freie Stelle eines
Taktes erzwungen werden. Der gesetzte Umruch wird nach dem gewählten
Takt ausgeführt. Die sichtbaren grünen Umbruchmarker dienen nur als
Hinweis und erscheinen nicht im Ausdruck.

Manchmal ist es wünschenswerte aufgetrennte Takte zu haben, also einen
Systemumbruch in der Mitte eines Taktes, statt an einem Taktstrich. Wenn
Sie zum Beispiel drei Schläge auf einem System und einen Schlag Auftakt im
nächsten notieren möchten, müssen Sie zwei Takte mit entsprechend
verkürzter effektiver Dauer erstellen. Eine entsprechende Darstellung kann
mit irregulären Takten erreicht werden, mehr dazu erfahren Sie unter Takte
bearbeiten in den Abschnitten „Dauer” und „Irregulär”.

Abstandhalter werden benötigt, um den Abstand zwischen zwei
benachbarten Notenzeilen zu vergrößern. Ziehen Sie einen Abstandhalter
auf einen Takt über dem Bereich, der vergrößert werden soll. Machen Sie
einen Doppelklick auf den Abstandhalter und ziehen Sie die Markierung um
die Größe zu verändern.

Wenn Sie die Grundeinstellung für den Notenzeilenabstand verändern
möchten, können Sie dies unter Format → Format-Stilvorgaben bearbeiten... →
Seite. Abstandhalter verändern nur die Notenzeile, in der sie sich befinden.

Rahmen
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Rahmen sind Platzhalter außerhalb der normalen Takte. Sie können leer sein
oder Texte oder Bilder enthalten. MuseScore kennt zwei Arten von Rahmen:

horizontal

Diese Rahmen unterbrechen ein Notensystem. Ihe Breite ist einstellbar,
die Höhe enspricht der aktuellen Systemhöhe. Sie werden z.B. zum
Absetzen einer Coda benutzt.

vertikal

Vertikale Rahmen schaffen Platz zwischen oder vor Notensystemen. Ihre
Höhe ist einstellbar und ihre Breite entspricht der Systembreite. Sie
werden z.B. für Titel, Subtitel oder Komponist genutzt. Beim Erstellen
eines Titels wird automatisch ein vertikaler Rahmen vor dem ersten Takt
erzeugt, wenn nicht bereits vorhanden.

Rahmen erzeugen
Zunächst muss der Takt ausgewählt werden, vor dem ein Rahmen einfügt
werden soll. Das Kommando zum Einfügen von Rahmen befindet sich unter
Erzeugen → Takte.

Rahmen löschen
Rahmen markieren und dann Entf drücken.

Rahmen bearbeiten
Ein Doppelklick innerhalb eines Rahmens schaltet in den
Bearbeitungsmodus. Es erscheint ein Anfasser, mit dem die Größe des
Rahmens verstellt werden kann.

Titelrahmen im Bearbeitungsmodus:
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Bilder
Sie können Bilder in Ihre Partitur einfügen oder Symbole, die nicht in einer
der Paletten vorhanden sind.

Ziehen Sie dazu einfach eine Image-Datei aus dem Explorer oder einem
anderen Dateiverwaltungsprogramm in MuseScore. MuseScore kann PNG
und JPEG Dateien importieren und bietet experimentellen Support für SVG,
bis jetzt noch ohne shading, blurring, clipping or masking.

Layout und Formatierung (englisch)
You've finished your score and you want to print it out. However, you want
improve how it looks. This handbook page describes many different ways,
and how they work together.

Ways to affect layout
• Layout → Page Settings. Change global settings such as page size, how big

a "space" is (under "Scaling"), and how big page margins are. Space is
used in other settings (example: "5.0sp"), so changing "space" will
change most other settings.

• Layout → Add More Stretch, Add Less Stretch. Stretch or squash measures
you select specifically.

• Style → Edit General Style → Page. Change global settings that affect how
close staves are, how close systems are, how much margin lyrics get, and
so on.

• Style → Edit General Style → System. Fix the number of measures per
system, or the measure width.

• Style → Edit General Style → Score. Affect score details like whether there
are multimeasure rests or empty staves are hidden.

• Style → Edit General Style → Measure. Set measure spacing, key to
controlling number of measures per line.

• Palette / Breaks & Spacer. Break a line at a particular measure, a
page at a particular line, or add space between measures.

• Style → Edit General Style → Sizes. Set the proportional size of "small" and
grace notes. Changing this would be unusual.

Layout / Page Settings
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Scaling / Space - This is the size of the space between 2 lines of a staff.
Since notes fit in that space, it also controls the size of note heads. Since
music is proportional to notes, this also affects note stems, accidentals, clefs,
all kinds of things. It also shows up as sp in many other settings (example:
system distance "9.2sp"). So, as you change the "Space" parameter, many
other settings change proportionally. For this reason, it is also sometimes
called "scaling."

Changing the scaling may not change the number of systems per page
because of the "page fill threshold" (see below). To see the effects of changes
to scaling without interference, set the "page fill threshold" to 100%.

Note: there is also a scaling parameter in Edit → Preferences → Score → Scaling.
That sets the global preference for new documents, but does not change the
current score.

Layout: Add More Stretch, Add Less Stretch

You can select measures, then widen them so fewer are on a line ("Add More
Stretch"), or squash them to fit more on a line ("Add Less Stretch").

Style / Edit General Style / Page
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• Music upper and lower margin - Space before and after the first and last
staves on a page.

• Staff distance - Space between staves within a system.

• Accolade distance - Space between the staves of a multi-staff instrument
like piano.

• System distance - Space between systems.

• Lyrics upper and lower margin - Space before and after the first and last
lines of lyrics

• V-frame upper and lower margin - Margins for a vertical frame (for
example, the box containing the title and composer info).

• Page fill threshold - If the page is fuller than this, system space is
ignored, and everything is stretched to fill the page. So 100% prevents
any stretching.

• Last system fill threshold - If the last system is larger than this
percentage of the page width, the last system is stretched to fill the page
width.

Percentages in a threshold are percentages of the full page height or width.
So a page fill threshold of 70% means stretch of things to fill the page, if it is
more than 70% full.

Style / Edit General Style / System

TODO

Style / Edit General Style / Score
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Here, you can cause the creation of multi-measure rests and hide empty
staves. This can affect score size greatly.

Style / Edit General Style / Measure

Set measure spacing as well as margins. The measure spacing is key to
controlling number of measures per line. Changing the other settings would
be unusual.

Palette / Breaks & Spacer

Using this palette, you can choose where you want page breaks or line
breaks. Some people do this first, and some save it until the end, after
modifying the global settings.

To put a page break, drag and drop the page break symbol to a measure. To
put a line break, drag and drop the line break symbol to the last measure you
want on a line. If you want the same number of measures for several
systems, select them and use Plugins → Break every X measures. If some
measures end up alone on the line, reduce the scaling, or use Layout → Add
More Stretch, Add Less Stretch.

See also Break or spacer.

Style / Edit General Style / Sizes

http://musescore.org/en/handbook/break-or-spacer
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Set the proportional size of "small" and grace notes. Changing this would be
unusual.

See also
• a video tutorial: http://musescore.org/en/node/10394

• A post by Marc Sabatella:
http://musescore.org/en/node/13138#comment-44678

http://musescore.org/en/node/10394
http://musescore.org/en/node/13138#comment-44678
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Kapitel 7

Themen für
Fortgeschrittene

Systemübergreifende Balkung
In der Klaviermusik wird eine zusammenhängende musikalische Phrase oft
über beide Notensysteme verteilt dargestellt (Bass- und Violinschlüssel). In
MuseScore wird so etwas wie folgt eingegeben:

Zunächst werden alle Noten in das obere System eingegeben:

Umsch+Strg+↓ verschiebt die ausgewählte Note oder den Akkord ins untere
System (Mac: ⌘+Shift+↓.)

Siehe auch: Taktstriche für Systemübergreifende Taktstriche.

Einzelstimmen
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Wenn Sie eine Partitur in MuseScore erstellt haben, können Sie daraus
Einzelstimmen erstellen, die nur die für jeden einzelnen beteiligten Musiker
benötigten Notenzeilen enthalten.

In aktuellen MuseScore-Versionen besteht die Erstellung eines
Einzelstimmenauszugs aus zwei Schritten:

1. Wahl der Instrumente, von denen ein Einzelstimmenauszug erstellt
werden soll

2. Die tatsächliche Erzeugung eines Auszugs

Stimmensatz festlegen
Sie können zu einem beliebigen Zeitpunkt nachdem Sie neue Partitur erstellt
haben den dazugehörigen Einzelstimmensatz festlegen. Sie müssen die
Konfiguration ihrer Einzelstimmen nur einmal durchführen, Sie können
jedoch jederzeit später Änderungen vornehmen. Im folgenden verwenden wir
als Beispiel eine Streichquartettpartitur, die Vorgehensweise ist auf jeden
andere Paritur übertragbar.

Öffnen Sie aus dem Menü Datei → Einzelstimmen....

2. Für jede Einzelstimme, klicken Sie den Button "Neu"

3. Geben Sie in den Eingabefeldern auf der rechten Seite für Dateiname 
und Titel passende Daten ein. 
„Dateiname” bezeichnet den Dateinamen unter dem ihre Einzelstimme 
gespeichert wird, nachdem sie erstellt wurde (Pflichtfeld).
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„Titel” wird als Überschrift in der Einzelstimme verwendet (optional).

4. Wählen Sie die Instrumente aus, die in diesem Einzelstimmenauszug
enthalten sein sollen. (Überlicherweise enthält jeder
Einzelstimmenauszug jeweils ein Instrument, Sie können aber auch
mehrere Instrumente in einem Auszug zusammenfassen)

Wiederholen Sie die obengenannten Schritte für jeden Auszug, soweit
nötig.

5. Drücken Sie "Schließen".

Diese Konfiguration ist vollständig und muss nicht wiederholt werden, es sei
denn Instrumente werden zur Partitur hinzugefügt oder entfernt. Sie haben
bereits gesehen, dass Sie auch mehrere Instrumente in einem Stimmauszug
unterbringen können (zum Beispiel können Sie aus doppelchörigen
Partituren Auszüge für jeweils einen der beiden Chöre erstellen), Sie können
allerdings Notenzeilen für ein einzelnes Instrument (mit zwei oder mehr
Stimmen) nicht auf mehrere Einzelstimmen verteilen. Jedes Intrument, das
einen eigenen Stimmauszug bekommen soll, braucht also seine eigene
Notenzeile. Berücksichtigen Sie dies bitte bei der Planung und Einrichtung
Ihrer Partitur

Generieren der Einzelstimmen
Nachdem Sie Ihre Partitur ausgeschrieben haben, oder Teile davon in 
Stimmauszügen ansehen möchten, können Sie den Notentext für die im
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vorigen Abschnitt eingerichteten Stimmauszüge generieren:

1. Öffnen Sie im Menü wieder Datei → Einzelstimmen....

2. Wählen Sie den Stimmauszug in der Auswahlliste aus der linken Seite.

3. Drücken Sie "Einzelstimme erstellen": im Hauptfenster wird ein neuer
Reiter sichtbar mit dem Stimmauszug, den Sie generiert haben.

Wiederholen Sie die Schritte 2 und 3 für jeden Stimmauszug. Es ist nicht
nötig, alle Stimmauszüge aus einmal zu generieren. Sie können
Stimmauszüge jederzeit wie oben beschrieben neu generieren lassen (falls
sich Änderungen an der Partitur ergeben haben), ohne sie neu einrichten zu
müssen.

Beachten Sie bitte:
Die neu erstellten Stimmauszüge sind nach der Erstellung noch nicht
gespeichert: Bitte speichern Sie alle Einzelstimmen nach Ihrer Erstellung,
damit keine Daten verloren gehen. Sie werden unter Umständen, bevor Sie
die entgültige Fassung sichern, Anpassungen an der Formatierung
vornehmen wollen.

Plug-Ins
Plug-Ins sind kleine Programmschnipsel, die MuseScore ein bestimmtes
Leistugsmerkmal hinzufügen. Durch das Hinzufügen eines Plug-Ins erscheint
ein neuer Eintrag im Plugins Menü von MuseScore. Es bewirkt eine
bestimmte Aktion auf eine Partitur oder einen Teil davon. Mithilfe von
Plug-Ins können auch Benutzer mit nur geringen Programmierfähigkeiten
Leistungsmerkmale zu MuseScore hinzufügen. Um Plug-Ins zu entwickeln,
bitte die Plug-In Dokumentation lesen.

Einige Plug-Ins werden zusammem mit MuseScore ausgeliefert (siehe
unten). Weitere sind im Plug-In Repository zu finden.

Hinweis: Der weit überwiegende Teil aller verfügbaren Plug-Ins liegt
ausschließlich in englischer Sprache vor.

Installation
Einige Plug-Ins benötigen für ihre Funktion die Installation zusätzlicher
Komponenten (z.B. Zeichensätze). Lesen Sie daher bitte die Dokumentation
des jeweiligen Plug-Ins .

Die meisten Plug-Ins werden als .zip Dateien bereitgestellt, also laden Sie 
diese herunter und entpacken es in eines der unten genannten 
Verzeichnisse. 
Einige werden als .js Dateien bereitgestellt, laden Sie diese herunter und 
plazieren es in diesen Verzeichnissen.

http://musescore.org/de/plugin-development
http://musescore.org/pt-br/manual-pt-br/plugins
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Einige werden als .txt Dateien bereitgestellt, laden Sie diese herunter und
plazieren es in diesen Verzeichnissen und benennen es so um, dass es auf .js
endet.

Windows
MuseScore sucht Plug-Ins in %ProgramFiles%\MuseScore\Plugins (bzw.
%ProgramFiles(x86)%\MuseScore\Plugins bei 64-bit Versions) und in
%LOCALAPPDATA%\MusE\MuseScore\plugins bei Vista und Sieben bzw.
C:\DoKumente und Einmstellungen\BENUTZERNAME\Local

Settings\Application Data\MusE\MuseScore\plugins (an Ihre
Sprachversion anpassen) bei XP.

MacOS X
Auf MacOS X sucht MuseScore nach Plug-Ins im MuseScore Bundle in
/Applications/MuseScore.app/Contents/Resources/plugins und in
~/Library/Application Support/MusE/MuseScore/plugins. Um Dateien in
das App Bundle zu bekommen, rechts-klick auf MuseScore.app und Auswahl
von "Show package contents", um das Contents Verzeichnis zu sehen.

Linux
In Linux sucht MuseScore nach Plug-Ins in
/usr/local/share/mscore-1.0/plugins und in
~/.local/share/data/MusE/MuseScore/plugins.

In jedem der oben genannten Fälle muss MuseScore neu gestartet werden,
um neue Plug-Ins zu laden.

Plug-Ins im Lieferumfang

ABC import
Diese Plug-Ins nutzt einen Webservice (http://abc2xml.appspot.com/) um
eine ABC Datei in MuseScore zu öffnen. Es unterstützt ABC 1.6. Die ABC
Datei wird zum Webservice gesendet und eine MusicXML Datei kommt
zurück. Das Plug-Ins zeigt diese dann als neue Partitur.

Chord chart
Diese Plug-Ins erzeugt eine Partitur mit allen von MuseScore unterstützten
Akkordnamen im Jazz Stil.

Color notes
Diese Plug-Ins färbt die Notenköpfe aller Noten in allen Notenzeilen gemäß
der "BoomWhackers" Konvention. Jede Tonhöhe bekomme eine andere
Farbe. C ind Cis haben eine unterschiedliche Farbe, Cis und Des dagegen die
Gleiche.
Um alle Noten wieder schwarz einzufärben, recht-klick auf einen Notenkopt
-> Auswählen -> Alle ähnlichen Elemente, Noch ein rechts-klick auf einen
Notenkopf -> Farbe -> schwarz.

Create scores

http://abc2xml.appspot.com/
http://en.wikipedia.org/wiki/abc_notation
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Diese Plug-Ins erzeugt eine neie Klavire-Partitir mir 4 Viertelnoten C D E F.
Es ist ein guter Anfang, um zu lernen, wie mit einem Plug-Ins eine neue
Partitur erzeugt und Noten hinzugefügt werden.

Note names
Diese Plug-Ins zeigt in der Nähe des Notenkopfes jeder Note der 1. Stimme
deren (englischen) Namen.

Test
Diese Plug-Ins ist nur ein Test und zeigt eine Dialogbox "Hello MuseScore".
Es ist ein guter Ausgangspunkt, um die Entwicklung von Plug-Ins zu lernen
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Kapitel 8

Support / Hilfe

Dieses Kapitel beschreibt, wie sie Hilfe für die Benutzung von MuseScore
finden: Orte an denen Sie Hilfe finden, eine Beschreibung, wie Sie Fragen im
MuseScore-Forum am besten formulieren, und Hilfestellung beim Verfassen
eines Fehlerreports.

Bekannte Konflikte mit anderer Software

Hardware / Treiber
• Samson USB Mikrophon, Treibername "Samson ASIO Driver",

samsonasiodriver.dll. Weitere Informationen

• Digidesign MME Refresh Service. Weitere Informationen

Software
• "Maple virtual cable" kann verhindern, dass MuseScore nicht richtig

beendet werden kann.

• Die Voreinstellungen unter KDE (Linux) können dazu führen, dass das
gesamte MuseScore-Fenster verschoben wird, wenn eine Note mit der
Maus verschoben wird. Ein ändern der Fenstereinstellungen des
Betriebssystems behebt das Problem.

Schriftarten-Probleme unter Mac OS X
Unter Umständen stellt MuseScore Noten als Quadrate dar, wenn bestimmte
Schriftarten unter MacOS X fehlerhaft sind.
Um das zu beheben, führen Sie folgende Schritte aus (Achtung: die
Beschreibung gilt für englischsprache Systeme, auf deutschen Versionen von
Mac OS X müssen Sie die entsprechenden Menüeinträge verwenden):

1. Öffnen Sie Applications -> Font Book

http://musescore.org/en/node/6849
http://musescore.org/en/node/6529
http://musescore.org/node/1335
http://musescore.org/node/1335
http://musescore.org/en/node/8318#comment-27683
http://musescore.org/en/node/8318#comment-27683
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2. Wählen Sie eine Schriftart aus und drücken Sie Cmd + A> um alle zu
Markieren.

3. Klicken Sie im Menü auf File -> Validate Fonts

4. Markieren und löschen Sie alle Schriftarten, die als beschädigt oder
probelamtisch angezeigt werden

5. Starten Sie MuseScore neu, falls nötig

In diesem Forumartikel glaubt ein Benutzer den Schriftart "Adobe Jenson
Pro (ajenson)" als Schuldigen ausgemacht zu haben, obwohl obiger Test sie
nicht als beschädigt oder problematisch anzeigte, und löste das Problem
durch Löschen der Schriftart, dies ist als auch einen Versuch wert.

Schriftart-Problem unter Linux
Wenn die voreingestellte Desktop-Schriftart auf fett eingestellt ist, wird
MuseScore Noten nicht richtig darstellen.
Um das zu beheben, führen Sie folgende Schritte aus:

Für GNOME 2.*/MATE Benutzer):

1. Recht-klick aufyIhren Desktop und wählen Sie "Desktop Hintergrund
ändern"

2. klicken Sie auf den Schriftarten-Reiter

3. Setzem Sie den Anwendungszeichensatz auf normalen Stil

4. Starten Sie MuseScore neu, falls nötig

Für GNOME 3/SHELL Benutzer:

1. Öffnen sie die Shell und öffnen "Advanced Settings"

2. Klicken Sie in der Liste auf die Optione für Schriftarten

3. Setzen Sie den voreingestellten Zeichensatz and irgendwas nicht fettes

4. Starten Sie MuseScore neu, falls nötig

"Speichern als" Dialog leer unter Linux
Einige Benutzer berichteten, dass der "Speichern als" Dialog unter Debian
6.0 und Lubuntu 10.10 leer ist
Um das zu beheben, führen Sie folgende Schritte aus:

1. Geben sie folgendes in einem Terminal-Fenster ein:
which mscore

2. Diese Kommando nennt Ihnen den Pfad zu mscore. Bearbeiten sie diese
Datei mit Ihrem bevorzugten Text-Editor und fügen am Anfang folgende
Zeile ein:
export QT_NO_GLIB=1

3. Starten Sie MuseScore neu und das Problem sollte gelöst sein.

http://musescore.org/en/node/13772#comment-53876
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Konfiguration zurücksetzen
Aktuelle Versionen von MuseScore bieten die Möglichkeit die Konfiguration
des Programms auf die Voreinstellungen zurückzusetzen. Falls
Konfigurationsdateien beschädigt sind oder anderweitige Probleme
auftauchen, kann diese Funktion den Normalbetrieb wiederherstellen.
Normalerweise sollte dies nicht nötig sein, wenden Sie sich deshalb am
besten zuerst an das Forum auf musescore.org mit einer detaillierten
Problembeschreibung, da auch die Möglichkeit bestehen kann, das Problem
zu beheben, ohne dass Sie alle Ihre Einstellungen verlieren.

Achtung: ein Zurücksetzen der MuseScore-Konfiguration auf die
Voreinstellungen führt dazu, dass Sie alle geänderten Einstellungen im
Programm verlieren.

Um MuseScore auf seine Ursprungskonfiguration zurückzusetzen, müssen
Sie das Programm mit dem Kommandozeilenparameter -F ausführen. Eine
Anleitung dafür finden Sie im Folgenden im Abschnitt zu Ihrem
Betriebssystem.

Anleitung für Windows
1. Schließen Sie bitte alle offenen MuseScore-Fenster, bevor Sie

fortfahren (Datei → Beenden).

2. Drücken Sie Windowstaste+R, um den Ausführen-Dialog zu öffnen. (Die
Windowstaste erkennen Sie am Microsoft Windows-Logo, sie befindet
sich üblicherweise links von der Leertaste).

3. Klicken Sie auf Durchsuchen...

4. Suchen Sie nach der Datei mscore.exe. Der Installationsort kann je
nach Konfiguration ihres Systems unterschiedlich sein, die Datei finden
Sie üblicherweise unter Arbeitsplatz > Lokale Festplatte > Programme >
MuseScore > bin > mscore.exe

5. Klicken Sie auf Öffnen um das Durchsuchen-Dialogfenster zu verlassen
und zum Ausführen-Dialogfenster zurückzukehren. Dort sollte jetzt (oder
so ähnlich) folgendes stehen:
C:\Programme\MuseScore\bin\mscore.exe

6. Klicken in das Bearbeitungsfeld und fügen Sie am Ende hinter
musescore.exe folgendes ein: ein Leerzeichen, gefolgt von einem
Bindestrich und einem großen F: -F

7. Drücken SieOK

Nach ein paar Sekunden sollte MuseScore mit zurückgesetzer Konfiguration
starten.

Fortgeschrittene Anwender finden die Hauptkonfigurationsdateien unter:

• Ab Windows Vista:
C:\Users\<BENUTZERNAME>\AppData\Roaming\MusE\MuseScore.ini

http://musescore.org/de/forum
http://de.wikipedia.org/wiki/windowstaste
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(Das Verzeichnis „Users” wird im Explorer als „Benutzer” angezeigt).

• Windows XP und frühere Versionen: C:\Dokumente und
Einstellungen\<BENUTZERNAME>\Application

Data\MusE\MuseScore.ini

Die weiteren Einstellungen (Palette, Sitzungen, etc) befinden sich in:

• Ab Windows Vista:
C:\Users\<BENUTZERNAME>\AppData\Local\MusE\MuseScore\

• Windows XP und frühere Versionen: C:\Dokumente und
Einstellungen\<BENUTZERNAME>\Lokale

Einstellungen\Anwendungsdaten\MusE\

Anleitung für Mac OS X
1. If you have MuseScore open then you need to quit the application first

(File → Quit)

2. From the Open Applications/Utilities/Terminal and a Terminal session
window should appear

3. Type, (or copy/paste) the following command into your terminal line
(include the '/' at the front):

/Applications/MuseScore.app/Contents/MacOS/mscore -F

This resets all MuseScore preferences to factory settings and immediately
launches the MuseScore application. You can now quit Terminal, and
continue using MuseScore.

For advanced users, the main preference file is located in
~/.config/muse.org/MuseScore.ini.
The other preferences (palette, session...) are in ~/Library/Application
Support/MusE/MuseScore/

Anleitung für Linux

Diese Beschreibung bezieht sich auf Ubuntu, beziehungsweise die
Gnome-Desktopumgebung, und muss für andere Linux-Distributionen
entsprechend angepasst werden

1. Schließen Sie bitte alle offenen MuseScore-Fenster, bevor Sie
fortfahren (Datei → Beenden).

3. Öffnen Sie im Ubuntu-( / Gnome-)Hauptmenü Anwendungen → Zubehör →
Terminal. Ein Terminal-Fenster sollte sich öffnen.

4. geben Sie in ein (Sie können die untere Zeile auch kopieren und im
Terminalfenster einfügen):
mscore -F
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MuseScore wird ausgeführt und die Einstellungen auf ihren
Ursprungszustand zurückgesetzt. Bitte beachten Sie, dass das Schließen des
Terminal-Fensters auch MuseScore beendet. Um dies zu umgehen, können
Sie musescore -F auch über das „Anwendung ausführen”-Dialogfenster
aufrufen, das sie in der Grundeinstellung über Alt+F2 finden.

Fortgeschrittene Anwender finden die Hauptkonfigurationsdateien unter:
~/.config/MusE/MuseScore.ini

Weiteren Einstellungen finden Sie den folgenden Verzeichnissen:
~/.config/MusE/

~/.config/MuseScore

Leitfaden für das Support-Forum und das
Erstellen eines Problemberichts
Bevor Sie im Forum um Hilfe bitten, oder einen Fehlerbericht abschicken:

• Wir möchten Sie bitten, zuerst im Handbuch nach einer Lösung des
Problems zu suchen.

• Verwenden Sie bitte die Suchfunktion auf musescore.org um
herauszufinden, ob das Problem bereits im Forum besprochen wurde.

• Wenn Sie einen Problembericht abschicken, versuchen Sie bitte zuerst,
das Problem mit der neuesten Vorabversion zu reproduzieren. Um zu
überprüfen, ob ein Problem in aktuellen Versionen bereits behoben
wurde, steht die Version-History zur Verfügung.

Beachten Sie bitte: Problemberichte (englisch: Bugreports) werden im
sogenannten Issue-Tracker veröffentlicht und zu Weiterverwendung
gespeichert. Bugreports werden grundsätzlich auf englisch verfasst und
beantwortet. Sollten Sie Schwierigkeiten bei der Verfassung eines
Bugreports haben, können Sie gerne im deutschen oder englischen
Support-Forum Hilfestellung bei der Formulierung erbitten.

Bitte nennen Sie nach Möglichkeit und soweit verfügbar folgende Daten in
Ihrem Problembericht:

• Die Version von MuseScore, die Sie benutzen (z.B. Version 1.0) oder die
Revionsnummer, wenn Sie eine Vorabversion benutzen (z.b. Revision
3996)

• Das Betriebssystem, auf dem Sie MuseScore verwenden (z.B. Windows
Vista, Windows 7, Mac OS 10.6 oder Ubuntu 10.10)

• Wenn Sie einen Fehler melden, beschreiben Sie bitte die genauen 
Schritte, die zu dem Problem führen (wohin Sie mit der Maus klicken, 
welche Tasten Sie drücken, was zu sehen ist). Leider ist es für das 
MuseScore-Entwicklerteam so gut wie nicht möglich, einen Fehler zu

http://musescore.org/de/forum
http://musescore.org/de/handbuch
http://musescore.org/de/search
http://musescore.org/de/forum
http://musescore.org/de/download
http://mscore.svn.sourceforge.net/viewvc/mscore/trunk/mscore/changelog
http://musescore.org/de/project/issues
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finden und zu beheben, der nicht zuverlässig reproduzierbar ist. Dies ist
in den meisten Fällen nur mit einer präzisen
Schritt-für-Schritt-Beschreibung möglich, die nachvollziehbar den Fehler
hervorruft.

• Beschränken Sie sich nach Möglichkeit auf einen Fehler pro
Problembericht. Wenn Sie mehrere Fehler entdeckt haben, verfassen Sie
bitte jeweils eigene Problemberichte für jeden einzelnen.

• Denken Sie auch bitte daran, dass das Hauptziel eines Problemberichts
nicht nur ist, auf eine Fehlfunktion hinzuweisen, sondern es anderen
möglichst einfach zu machen, den Fehler nachzuvollziehen.
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Kapitel 9

Anhang

Glossar
Die folgende Auflistung ist ein Glossar von wichtigen Begriffen, die in
MuseScore vorkommen, mit einer Erklärung.

Acciaccatura

Kurze Vorschlagsnote. Siehe →Vorschlagsnote

Akkord (engl. Chord)

Ein Akkord besteht aus zwei oder mehreren gleichzeitig erklingenden
Tönen, die untereinander notiert werden. Im Gegensatz zur Notation in
getrennten Stimmen haben alle Akkordtöne die gleiche Dauer.

Appoggiatura

Lange Vorschlagsnote. Siehe →Vorschlagsnote

Balken (engl. Beam)

Noten mit einem Notenwert von einer Achtel oder weniger werden
entweder mit einem Fähnchen oder Balken versehen. Balken dienen der
Gruppierung mehrerer Noten.

Betriebssystem (engl. Operating System (OS))

Die Arbeitsumgebung eines Computers. Das Betriebssystem stellt die
Basissoftware für den Betrieb den Computers zur Verfügung. Darüber
hinaus sind oftmals Anwendungssoftware und eine Reihe von
Hilfsprogrammen Teil des Betriebssystems. Verbreitete Betriebssysteme
sind Microsoft Windows, Mac OS X, und GNU/Linux.

Bindebogen (engl. Slur)
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Bindebögen und Haltebögen bezeichnen optisch identische gebogene
Linien zwischen zwei oder mehreren Noten. Ein Bindebogen markiert
einen legato zu spielenden Abschnitt, oder kennzeichnet eine
musikalische Phrase (dann auch: Phrasenbogen), während der
Bindebogen zwei gleiche Noten zu einer zusammenfügt, deren Länge
den addierten Tondauern entspricht, die zweite Note unter einem
Bindebogen wird also nicht erneut gespielt.
Ein Bindebogen wird unter anderem aus Gründen der besseren
Lesbarkeit verwendet, wenn der gewünschte Notenwert nicht mit einer
Note dargestellt werden kann oder bei Noten die sich über mehrere
Takte erstrecken.
Beispiele:

Viertelnote + Bindebogen + Viertelnote = Halbe Note
Viertelnote + Bindebogen + Achtelnote = punktierte Viertelnote
Viertelnote + Bindebogen + Achtelnote + Bindebogen + 16tel-Note =
doppelt punktierte Viertnote

BPM

Beats per Minute (Schläge pro Minute). Siehe →Metronomangabe

Duole (engl. Duplet)

Siehe →N-tole

Einzelstimme (engl. Part)

Auszug aus einer Partitur. Während eine Partitur Notenzeilen für alle
Instrumente enthält, besteht eine Einzelstimme (auch Stimmen genannt,
aber nicht zu verwechseln mit dem MuseScore-Konzept von Stimmen bei
der Noteneingabe) nur aus den Notenzeilen für die jeweilige
Musikergruppe.

Fähnchen, auch: Fahne (engl. Flag)

Siehe →Balken.

Haltebogen (engl. Tie)

Siehe →Bindebogen

Metronomangabe

Metronomangabe werden üblicherweise wie folgt notiert: Notenwert =
Geschwindigkeit. Die Geschwindigkeit wird hierbei in bpm angegeben,
bpm ist eine englische Bezeichnung und steht für „beats per minute”,
also Schläge pro Minute. In manchen älteren Partituren findet sich auch
noch das deutsche „M.M.”, nach „Mälzels Metronom”. In MuseScore
kommen Metronomangaben in Tempo-Text vor.
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M.M.

Mälzels Metronom. Siehe →Metronomangabe

Notenzeile (engl. Staff, plur. Staves)

Eine Gruppe von horizontalen Linien, für die meisten Instrumente fünf,
auf denen die Musik notiert wird. Notenlinien entstanden im 11.
Jahrhundert und hatten ursprünglich vier Linien (Gregorianische
Notation).

N-tole (engl. Tuplet)

Eine N-tole teilt einen übergeordneten Notenwert in einem anderen
Verhältnis, als es die Taktart vorgibt. Die Triole beispielsweise teilt in
einem geraden Takt den nächstgrößeren Notenwert in 3 statt 2 Teile.
N-tolen sind unter anderem: Triolen, Duolen, Quintolen.

Quartuole (engl. Quadruplet)

Siehe →N-tole

Quintole (engl. Quintuplet)

Siehe →N-tole

Sextole (engl. Sextuplet)

Siehe →N-tole

Stimme (engl. Voice)

Akkordinstrumente, aber auch einige Melodieinstrumente und das
Schlagzeug, benötigen die Möglichkeit auf einem System (in einer
Notenzeile) Noten unterschiedlicher Tondauern gleichzeitig zu notieren
um Stimmführungen mit unabhängigen Rhythmen darzustellen.
MuseScore trennt dazu die Eingabe in Stimmen, die jeweils einzeln
eingegeben werden.

Schlüssel, auch: Notenschlüssel (engl. Clef)

Der Notenschlüssel ist ein Symbol, das zumindest am Anfang einer jeden
Notenzeile steht und die Tonhöhen der Notenlinien und deren
Zwischenräume festlegt.
Die gebräuchlichsten Schlüssel sind der F-, C- und der G-Schlüssel, die
jeweils auf einer der fünf Notenlinien platziert werden können. Die am
häufigsten verwendeten Beispiele sind der G-Schlüssel auf der 2. Linie
(der Violinschlüssel) und der F-Schlüssel auf der 4. Linie (Bassschlüssel).

System, auch: Akkolade (engl. System)
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System: die Summe der zusammengehörigen Notenzeilen einer Partitur.

Triole (engl. Triplet)

Siehe →N-tole

Versetzungszeichen auch: Akzidentien (engl. Accidental)

Vorzeichen, die in der Partitur vor einzelnen Noten stehen, werden
Versetzungszeichen genannt. Ihr Geltungsbereich erstreckt sich von der
dazugehörigen Note bis zum jeweiligen Taktende, ein zuvor
aufgetretenes Versetzungszeichen kann aber durch anderes
Versetzungszeichen auf der selben Linie bzw. Zwischenraum aufgehoben
werden. Versetzungszeichen die bereits in der Tonartvorzeichnung
vorhanden sind, müssen im Stück nicht mehr notiert werden. Die
gängigsten Vertreter sind das "Kreuz", das "b", das "Auflösungszeichen",
seltener Doppel-Kreuz und Doppel-B.

Vorschlagsnote (engl. Grace note)

Vorschlagsnoten werden als kleine Noten vor ihrer Hauptnote notiert.
Eine kurze Vorhaltsnote (Acciaccatura) hat einen durchgestrichenen
Hals, eine lange Vorhaltsnote (Appoggiatura) nicht.

Vorzeichen (Tonart) (engl. Key Signature)

Vorzeichen stehen am Anfang eines Stückes und legen die Tonart des
Stücks fest. Sie werden nicht wie der Notenschlüssel in jeder neuen
Zeile wiederholt, es können aber in der Mitte eines Stückes weitere
Vorzeichnungen auftreten, die einen Tonartwechsel anzeigen.
Tonartvorzeichen bestehen aus den selben Symbolen wie
Versetzungszeichen, haben aber einen anderen Geltungsbereich.

Tastenbefehle
Sie finden alle Tastenbefehle im Menü unter Bearbeiten → Einstellungen... →
Tastenbefehle Reiter (Mac: MuseScore → Einstellungen... → Tastenbefehle Reiter). In
den untenstehenden Liste sind die Voreinstellungen aufgeführt.

Navigation
Anfang der Partitur: Pos1

Ende der Partitur: Ende

Nächste Seite: Bild ↑

Vorherige Seite: Bild ↓

Nächster Takt: Strg+→ (Mac ⌘+→)
Vorheriger Takt: Strg+← (Mac ⌘+←)
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Nächste Note: →
Vorherige Note: ←

Eine Note nach unten: Alt+↓

Eine Note nach oben: Alt+↓

Oberste Note im Akkord: Strg+Alt+↑ (Unter Linux kann diese
Tastenkombination für den Arbeitsflächenwechsel vorgesehen sein)
Bottom note in chord: Strg+Alt+↓ (Unter Linux kann diese Tastenkombination
für den Arbeitsflächenwechsel vorgesehen sein)

Noteneingabe
Noteneingabemodus an-/ausschalten: N
Noteneingabemodus verlassen: Esc

Tondauern
Mit 1 ... 9 wählen Sie eine Tondauer. Siehe hierzu das Kapitel Noteneingabe.

Halbieren der letzten Note: Q
Verdoppeln der letzten Note: W

Stimmen
Erste Stimme: Strg+I Strg+1 (Mac ⌘+I ⌘+1)
Zweite Stimme: Strg+I Strg+2 (Mac ⌘+I ⌘+2)
Dritte Stimme: Strg+I Strg+3 (Mac ⌘+I ⌘+3)
Vierte Stimme: Strg+I Strg+4 (Mac ⌘+I ⌘+4)

Tonhöhe
Wenn Sie Notennamen über die Buchstaben Ihrer Tastatur eingeben oder
ein Angeschlossenes MIDI-Keyboard verwenden möchten, lesen Sie bitte
auch die ausführliche Anleitung im Kapitel Noteneingabe.

Wiederholen der letzten Note: R

Eine Oktave höher: Strg+↑ (Mac ⌘+↑)
Eine Oktave tiefer: Strg+↓ (Mac ⌘+↓)

Einen Halbton höher: ↑
Einen Halbton tiefer: ↓

Kreuz hinzufügen: (zur Zeit nicht voreingestellt wegen eines möglichen
Konflikts mit der Zoom-Funktion)
b Hinzufügen: -

Pause: 0 (zero). In MuseScore-Versionen bis zu 0.9.6: Leertaste

Intervalle
Mit diesen Tastenkombinationen können Sie Noten in Intervallabständen zur 
ausgewählten Note hinzufügen 
Intervall über der Note: Alt+[Zahl]
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Intervall unter der Note: Umschalt⇑+[Zahl]

Elemente umdrehen
Richtung eines Elements umdrehen (z.B. Balken, Bögen, Triolen-Klammern):
X

Notenkopf umdrehen: Umschalt⇑+X

Artikulation
Haltebogen: +
Bindebogen S
Staccato: Umschalt⇑+.

Crescendo-Gabel: H
Diminuendo-Gabel: Umschalt⇑+H

Liedtext
Vorherige Silbe: Strg+← (Mac ⌘+←)
Nächste Silbe: Strg+→ (Mac ⌘+→)

Eine Strophe nach oben: Strg+↑

Eine Strophe nach unten: Strg+↓

Weitere Tastenkürzel und eine umfangreiche Anleitung zur Liedtexteingabe
finden sie im Kapitel Liedtext

Ansicht
Paletten: F9 (Mac: ⌥+⌘+K)
Mischpult: F10 (Mac: ⌥+⌘+M)
Wiedergabepult: F11 (Mac: ⌥+⌘+P)
Navigator: F12 (Mac: ⌥+⌘+N)
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